
MacBook Pro
Getting Started Guide

Look around your new Mac
Get a quick intro to MacBook Pro ports, connectors, accessories, and other features.

Take a tour of MacBook Pro
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Start your MacBook Pro by lifting the lid or pressing any key. Follow the Setup Assistant prompts, and
you’re up and running.

Set up your MacBook Pro

If you’re new to Mac
Discover what your new MacBook Pro with macOS Sequoia can do. Especially if you’re switching from a
Windows PC, these tips and tricks can get you up and running.
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Do more
Your MacBook Pro comes with built-in apps that help you stay connected, empower you to create, provide
hours of entertainment, and more.

Learn what you can do with apps on your MacBook Pro



Discover new features
Find out what's new in macOS Sequoia and your included apps.

New features for macOS Sequoia

This MacBook Pro Getting Started Guide is for the current MacBook Pro models. To explore the guide, click
Table of Contents at the top of the page, or enter a word or phrase in the search field.

If you need more help, visit the MacBook Pro Support website.

Not all features and content are available in all countries or regions.
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MacBook Pro at a glance

Take a tour of MacBook Pro
Note: This guide is for the currently shipping MacBook Pro models. If you’re not sure which model you have
or want to find information and documentation for other models, see the Apple Support article Identify your
MacBook Pro model.

Not all features are available on all MacBook Pro models.

Thunderbolt (USB-C) ports: Use any of the three Thunderbolt (USB-C) ports to transfer data at
Thunderbolt speeds (up to 40 Gbit/s for Thunderbolt 4 on and up to 120 Gbit/s for Thunderbolt 5 on ),
connect to a display or projector, connect to USB 4 peripherals, and more. The ports can also charge
devices, such as an iPhone or a rechargeable trackpad or keyboard, as well as charge your
MacBook Pro using a USB-C Charge Cable.

Tip: To see how many displays you can connect to your MacBook Pro, see Use an external display with your
MacBook Pro.

MagSafe 3 port: Connect the USB-C to MagSafe 3 cable to the included power adapter to recharge the
MacBook Pro battery. The indicator light glows amber when the battery is charging, and green when
it’s fully charged. Charge your battery quickly—up to 50 percent in about 30 minutes—on the 14-inch
model with the 96W USB-C Power Adapter and on the 16-inch model with the 140W USB-C Power
Adapter.

3.5 mm headphone jack: Plug in stereo headphones or external speakers to listen to your favorite music
or movies. Your MacBook Pro supports the use of high-impedance headphones without an additional
headphone amplifier.

SDXC card slot: Transfer photos, videos, and data to and from your MacBook Pro, with support for
high-capacity SD 4.0 cards.

HDMI port: Connect your MacBook Pro to a TV or external display. See Use an external display with
your MacBook Pro.
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12MP Center Stage Camera: Make FaceTime video calls or take pictures and video. The camera
system provides high-quality video, Center Stage, and Desk View. If the green indicator light next to
the camera is glowing, the camera is on. See FaceTime and Use the built-in camera on Mac.

Studio-Quality Microphones: Three microphones with high signal-to-noise ratio and directional
beamforming deliver super-clear audio for videoconferencing and phone calls, as well as high-quality
voice recordings for audio tracks, podcasts, and voice memos.

Speakers: The high-fidelity six-speaker sound system consists of two pairs of dual force-canceling
woofers and two tweeters. Enjoy a robust and high-quality audio experience, including Spatial Audio
support for videos and songs with Dolby Atmos.

Touch ID (the power button): Press to turn on your MacBook Pro (or just lift the lid or press any key).
A metallic trim ring guides your finger to the Touch ID sensor that analyzes your fingerprint. When you
first start up or restart, you need to log in by typing your password. To learn more about how to use
Touch ID, see Magic Keyboard for MacBook Pro.

Force Touch trackpad: Control your MacBook Pro with gestures. The entire trackpad surface acts as a
button so you can easily click anywhere. For more about using gestures, see MacBook Pro trackpad.

What’s included with your MacBook Pro
To use your MacBook Pro, you need two accessories included in the box—a cable and one of the power
adapters listed below.

Accessory Description

USB-C to MagSafe 3 Cable: To charge your
MacBook Pro, connect one end of the USB-C to MagSafe
3 Cable to the MagSafe 3 port on your MacBook Pro, and
the other end to the included power adapter. When you
first connect the cable to MacBook Pro, a battery status
indicator on the connector starts to glow: green for fully
charged or amber for charging.

70W USB-C Power Adapter: For 14-inch
MacBook Pro. After the power adapter is connected, fully
extend the electrical prongs on the AC plug, and plug the
adapter into an AC power outlet.
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96W USB-C Power Adapter: For 14-inch
MacBook Pro. After the power adapter is connected, fully
extend the electrical prongs on the AC plug, and plug the
adapter into an AC power outlet. The 96W USB-C Power
Adapter fast charges the 14-inch MacBook Pro up to 50
percent in around 30 minutes using either the included
USB-C to MagSafe 3 Cable or the 240W USB-C Charge
Cable (sold separately).

140W USB-C Power Adapter: For 16-inch
MacBook Pro. After the power adapter is connected, fully
extend the electrical prongs on the AC plug, and plug the
adapter into an AC power outlet. The 140W USB-C
Power Adapter fast charges MacBook Pro to
approximately 50 percent in around 30 minutes using
either the included USB-C to MagSafe 3 Cable or the
240W USB-C Charge Cable (sold separately).

Other adapters and accessories are sold separately. Visit apple.com, your local Apple Store, or other resellers
for more information and availability. Review the documentation or check with the manufacturer to make
sure you choose the right product.

Magic Keyboard for MacBook Pro
The Magic Keyboard with Touch ID has built-in features that make it easy to enter emoji, switch keyboard
languages, lock your MacBook Pro, and perform many system functions with the touch of a key. When you
set up Touch ID, you can use your fingerprint to unlock MacBook Pro; quickly lock your screen; sign in to a
website or app with a passkey; or make purchases from the App Store, Apple TV app, and Apple Books, and
on websites using Apple Pay.

Set up Touch ID. You can set up Touch ID during setup, or at a later time in Touch ID & Password in
System Settings. For more information about Touch ID, see Use Touch ID on Mac.

Turn on your MacBook Pro. Lift the lid, press Touch ID (the power button), or press any other key.

Use Touch ID. After you set up Touch ID, when you start up or restart the computer, you need to log in by
typing your password. After initial login, whenever you’re asked for your password in the same session, you
can just place your finger lightly on the Touch ID sensor to authenticate. You can also use Touch ID to make
online purchases securely with Apple Pay. For more information about Apple Pay, see Use Wallet & Apple
Pay.

Lock your MacBook Pro. Press Touch ID to quickly lock your screen.

https://store.apple.com/
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Turn off your MacBook Pro. To turn off your MacBook Pro, choose Apple menu   > Shut Down. To put

your MacBook Pro to sleep, choose Apple menu   > Sleep.

Use function keys on your MacBook Pro. The function keys on the top row of the MacBook Pro provide
shortcuts for these common system functions:

Brightness (F1, F2): Press   or  to decrease or increase the brightness of the screen.

Mission Control (F3): Press   to view what’s running on your MacBook Pro, including all your
spaces and open windows.

Spotlight Search (F4): Press   to open Spotlight and search for something on your MacBook Pro.

Dictation/Siri (F5): Press   to activate dictation—you can dictate text wherever you can type (for

example, in Messages, Mail, Pages, and other apps). To activate Siri, press and hold , then
immediately speak your request.

Do Not Disturb (F6): Press  to turn Do Not Disturb on or off. When Do Not Disturb is on, you
won’t see or hear notifications on MacBook Pro, but you can view them later in Notification Center.
See Notification Center to learn more.

Media (F7, F8, F9): Press   to rewind,  to play or pause, or   to fast-forward a song,
movie, or slideshow.

Mute (F10): Press   to mute the sound from the built-in speakers or 3.5 mm headphone jack.

Volume (F11, F12): Press   or  to decrease or increase the volume of sound from the built-in
speakers, 3.5 mm headphone jack, or Bluetooth audio device.

Note: Function keys can perform actions in specific apps or may have alternative functions—for example, the
F11 key can hide all open windows and show the desktop. To trigger the alternative function associated with

a key, press and hold the Function (Fn)/Globe key  while you press a function key.

Adjust keyboard settings. To specify options for the keyboard and the Function (Fn)/Globe key , open
System Settings, then click Keyboard in the sidebar. You can change the keyboard brightness and backlight;

select whether pressing the Function (Fn)/Globe key  shows the emoji picker/Character Viewer, changes
the input source, or starts dictation; adjust keyboard shortcuts; and more. To learn more about keyboard
settings, see Change Keyboard settings on Mac.
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Use emoji and symbols. Press the Function (Fn)/Globe key  to pull up the emoji picker (if you’ve set up
this option in Keyboard settings). When the emoji picker is open, explore emoji by categories or with search
and insert symbols like pictographs.

Learn about keyboard shortcuts. You can press key combinations to quickly perform certain tasks on your
MacBook Pro, or to do things that you would normally use a mouse or trackpad for. For example, press
Command-C to copy selected text, then click where you want to paste the text and press Command-V. For a
list of commonly used shortcuts, see Keyboard shortcuts on your Mac. If you’re new to the Mac, you might
also be interested in Are you new to Mac?

MacBook Pro trackpad
You can do a lot on your MacBook Pro using simple trackpad gestures—scroll through webpages, zoom in
on documents, rotate photos, and more. With the Force Touch trackpad, pressure-sensing capabilities add
another level of interactivity. The trackpad provides feedback—when you drag or rotate objects, you feel a
subtle vibration when they’re aligned, allowing you to work with greater precision. For examples of force
touch options, see the Apple Support article How to use the Force Touch trackpad.

Here are some common gestures.

Gesture Action
Click: Press anywhere on the trackpad. Or enable “Tap to click” in Trackpad Settings,
and simply tap.

Force click: Click and then press deeper. You can use force click to look up more
information—click a word to see its definition, or an address to see a preview that you
can open in Maps.
Secondary click (that is, right-click): Click with two fingers to open shortcut menus.
If “Tap to click” is enabled, tap with two fingers. On the keyboard, press the Control
key and click the trackpad.

Two-finger scroll: Slide two fingers up or down to scroll.

Pinch to zoom: Pinch your thumb and finger open or closed to zoom in or out of photos
and webpages.

Swipe to navigate: Swipe left or right with two fingers to flip through webpages,
documents, and more—like turning a page in a book.

Open Launchpad: Quickly open apps in Launchpad. Pinch closed with four or five
fingers, then click an app to open it.
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Swipe between apps: To switch from one full-screen app to another, swipe left or right
with three or four fingers.

Customize your gestures. In System Settings, click Trackpad in the sidebar. You can do the following:

Learn more about each gesture

Set the click pressure you prefer to use

Decide whether to use pressure-sensing features

Control the tracking speed

Customize other trackpad features

Tip: If you find you’re force clicking when you don’t intend to, try adjusting the click pressure to a firmer
setting in Trackpad Settings. Or click the pop-up menu next to “Look up & data detectors” and choose Tap
with Three Fingers.

If you would like to use a Bluetooth® mouse or trackpad in addition to the trackpad on your MacBook Pro,
learn how to set it up at Use accessories with your MacBook Pro.

Charge the MacBook Pro battery
The battery in your MacBook Pro recharges whenever the MacBook Pro is connected to power.

Charge the battery. Connect your MacBook Pro to a power outlet using the included cable and power
adapter. To learn more about the adapter and cable that came with your MacBook Pro, see What’s included
with your MacBook Pro.

Show battery status in menu bar. Add a battery icon to your menu bar so you can quickly see information
about your battery and open Battery settings. In System Settings, click Control Center, then go to Battery on
the right and click Show in Menu Bar. You can also choose to show battery percentage in the menu bar.

Customize battery settings. You can set different options for your battery in System Settings.

Optimized Battery Charging: This feature helps to reduce the wear on your battery and improve its
lifespan by learning your daily charging routine. It delays charging the battery past 80% when it
predicts that you’ll be plugged in for an extended period of time, and aims to charge the battery before

you unplug. In System Settings, click Battery in the sidebar, click  by Battery Health, then turn on
Optimized Battery Charging.

Low Power Mode: This option reduces energy usage. This is a good option for travel or when you’re
away from a power source for an extended period of time. In System Settings, click Battery in the
sidebar, then choose from the options in the Low Power Mode pop-up menu.

High Power Mode: Available on the . When High Power Mode is selected, your Mac allows the fans to
run at higher speeds to maximize performance during intensive workloads. In System Settings, click
Battery in the sidebar, then choose from the options in the High Power Mode dropdown. When you’re



using in High Power Mode and want to use a power adapter, use the 96W USB-C Power Adapter or
140W USB-C Power Adapter for best performance.

Note: To customize other advanced settings, like dimming the display on battery, preventing automatic
sleeping, and when to wake for network access, click Options in Battery Settings.

Connect the power adapter. To charge the battery, use the MagSafe 3 port or any of the Thunderbolt (USB-
C) ports on your MacBook Pro.

Note: You can fast charge your MacBook Pro up to 50 percent in about 30 minutes. To fast charge the 14-
inch MacBook Pro, use the 96W USB-C Power Adapter with either the included USB-C to MagSafe 3 Cable
or the 240W USB-C Charge cable (sold separately). To fast charge the 16-inch MacBook Pro, use the
140W USB-C Power Adapter with either the included USB-C to MagSafe 3 Cable or the 240W USB-C
Charge cable (sold separately).

Check the battery’s charge. Look at the battery status icon at the right of the menu bar to see the battery
level or charging status. Or go to System Settings and click Battery in the sidebar.

Battery usage history. Go to System Settings and click Battery to see your battery’s usage over the past 24
hours or the last 10 days.

Conserve battery power. To extend battery life on a given charge, you can reduce the display brightness,
close apps, and disconnect peripheral devices you’re not using. In System Settings, click Battery in the



sidebar to change your power settings. If your MacBook Pro is in sleep when a device is connected to it, the
device’s battery may drain.

Learn more. For more information about:

How to monitor the battery in your Mac or check its condition, see Monitor your Mac laptop’s battery
and Check the condition of your Mac laptop’s battery.

If your Battery Health says Service Recommended, see the Apple Support article If you see Service
Recommended on your MacBook Air or MacBook Pro.

Charging issues with your power adapter, see the Apple Support articles If your USB-C power adapter
isn’t charging your Mac laptop, If your MagSafe cable or power adapter isn’t working, and If your Mac
battery status is “Not Charging”.

The internal, rechargeable battery in your MacBook Pro, and for conservation and performance tips,
see Apple Lithium-ion Batteries.

Adapters for your MacBook Pro
The following Apple adapters are available to connect your MacBook Pro to power, external devices and
displays, and more.

To see where your ports are located on your MacBook Pro, see Take a tour of MacBook Pro. You can learn
about each port, and what it looks like, with the Apple Support Article Identify the ports on your Mac.

Cable or Adapter Description

USB-C to USB Adapter: Connect your MacBook Pro to
standard USB accessories.

USB-C to Lightning Cable: Connect your iPhone or
other iOS or iPadOS device with Lightning connector to
your MacBook Pro for syncing and charging.

USB-C Charge Cable: Connect your iPhone or other
iOS or iPadOS device with USB-C connector to your
MacBook Pro for syncing and charging.
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USB-C Digital AV Multiport Adapter: Connect your
MacBook Pro to an HDMI display, while also connecting
a standard USB device and a USB-C charge cable to
charge your MacBook Pro.

USB-C VGA Multiport Adapter: Connect your
MacBook Pro to a VGA projector or display, while also
connecting a standard USB device and a USB-C charge
cable to charge your MacBook Pro.

Thunderbolt 3 (USB-C) to Thunderbolt 2 Adapter:
Connect your MacBook Pro to Thunderbolt 2 devices.
The Thunderbolt 3 (USB-C) adapter can be used with the
Thunderbolt (USB-C) ports on your MacBook Pro.

Learn more. See the Apple Support article Adapters for the Thunderbolt or USB-C ports on your Mac.

Adapters and other accessories are sold separately. Visit apple.com, your local Apple Store, or other resellers
for more information and availability. Review the documentation or check with the manufacturer to make
sure you choose the right product.

Use accessories with your MacBook Pro
You can connect your MacBook Pro with other devices, like a keyboard, mouse, or trackpad; wearable
devices like AirPods; and more. There are two ways to connect accessories: wirelessly using Bluetooth
technology or by connecting a cable from the accessory to one of the Thunderbolt (USB-C) ports on your
MacBook Pro.

Before you begin. Before you connect an accessory to your MacBook Pro, do the following:

Consult the documentation that came with your accessory.

If you are connecting with a cable, make sure you have the correct cable. You may also need an adapter
to connect the cable to the port on your MacBook Pro. To learn more about your ports and their
capabilities, see Take a tour of MacBook Pro.

Make sure your MacBook Pro is updated to the latest version of macOS.

Connect a wireless accessory

Turn Bluetooth on. Click  in the menu bar. The Bluetooth icon  is blue or another color when it’s
turned on. If the icon is gray, click it to turn Bluetooth on.

Pair a Bluetooth accessory. The first time you use a Bluetooth accessory with your MacBook Pro, you must
pair them. Consult the documentation that came with your accessory to make sure it is ready to pair—for
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instance, you may need to flip a switch on the accessory to turn on Bluetooth. Both your Mac and the
accessory must be turned on and near each other.

When your accessory is ready to pair, open System Settings on your Mac and click Bluetooth in the sidebar.
Select the accessory in the Nearby Devices list, then click Connect.

Connect a Bluetooth accessory. After you’ve paired an accessory, it automatically connects to your
MacBook Pro. You can check to see what Bluetooth devices you have connected to your MacBook Pro by

clicking  in the menu bar, then move your pointer over Bluetooth and click . Accessories that appear in
the list with a blue (or a different color) icon are connected.

If your accessory isn’t automatically connecting, open System Settings on your Mac and click Bluetooth.
Make sure the accessory appears in the My Devices list. If it doesn’t appear, follow the steps to pair the
accessory.

Disconnect or forget a Bluetooth accessory. To disconnect a Bluetooth accessory, open System Settings on
your Mac and click Bluetooth. In the My Devices list, move your pointer over the accessory, then click
Disconnect. To forget a Bluetooth accessory so your MacBook Pro doesn’t automatically connect to it, click

 next to the accessory, then click Forget This Device.

Connect a Magic Mouse, Magic Trackpad, or Magic Keyboard. Connect the Magic Mouse, Magic
Trackpad, or Magic Keyboard to your MacBook Pro using the cable provided with your accessory. Then,
slide the switch on your accessory to on, so that the green is visible. Your accessory then pairs with your
Mac.

After the accessory is paired with your MacBook Pro, you can disconnect the cable and use the accessory
wirelessly. Your Magic Mouse, Magic Trackpad, or Magic Keyboard automatically connects to your Mac
when Bluetooth is turned on.

Connect AirPods with your MacBook Pro. To pair and connect AirPods, see Pair AirPods with an Apple
Device.

Connect an accessory with a cable

Some accessories can be connected to your MacBook Pro with a cable. Depending on the capabilities of the
accessory and the cable, you may also be able to charge the accessory or transfer data when connected.

Consult the documentation that came with your accessory before connecting it. Some accessories have an
additional power source that also needs to be plugged in.

To connect an accessory, you need to use a cable that fits both the port on your accessory as well as the
Thunderbolt (USB-C) port on your MacBook Pro. If the cable doesn’t have the right connector for your Mac,
you may use an adapter to connect the cable. For more information about adapters, what they look like, and
what ports to use, see Adapters for the Thunderbolt or USB-C ports on your Mac.

Tip: Some accessories need to be approved the first time they’re connected, see Allow accessories to connect
to Mac to learn more.

Learn more. See Bluetooth settings on Mac and About USB on Mac. To learn more about connecting a
Magic Mouse, Magic Trackpad, or Magic Keyboard, see Set up your Magic Keyboard, Magic Mouse, or
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Magic Trackpad with your Mac. If you see a note that USB devices are disabled, see If you see USB Devices
Disabled on your Mac.

Use an external display with your MacBook Pro
You can use an external display, like the Apple Studio Display, or a projector or high resolution TV with your
MacBook Pro. The HDMI and Thunderbolt ports on your MacBook Pro support video output.

Before you begin

Connect your display to power before you connect it to MacBook Pro.

Use the correct cable for your display. Check the documentation that came with your display and make sure
you have the correct cable to connect your display.

Identify the ports on your MacBook Pro. Before you connect a display to your MacBook Pro, it’s useful to
know what ports your Mac has. To familiarize yourself with the ports on your MacBook Pro and where they
are located, see Take a tour of MacBook Pro. To learn more about different types of ports and what they do,
see Identify the ports on your Mac.

Connect a display to MacBook Pro

. You can connect up to two external displays in the following configurations:

Connect one external display with up to 6K resolution at 60 Hz using a Thunderbolt port and one
external display with up to 4K resolution at 144 Hz using the HDMI port.

Connect up to two external displays with up to 6K resolution at 60 Hz using the Thunderbolt ports.

You can also connect a single display with up to 8K resolution at 60 Hz or up to 4K resolution at 240 Hz
using the HDMI port.

.You can connect up to four external displays in the following configurations:

Connect up to three external displays with up to 6K resolution at 60 Hz using the Thunderbolt ports
and one external display with up to 4K resolution at 144 Hz using the HDMI port.

Connect up to two external displays with up to 6K resolution at 60 Hz using the Thunderbolt ports and,
using the HDMI port, either one external display with up to 8K resolution at 60 Hz or one external
display with up to 4K resolution at 240 Hz.

To learn more about using an 8K display with your MacBook Pro, see the Apple Support Article Use an 8K
display with your Mac.

If you’re not sure how many external displays your MacBook Pro supports, check Technical Specifications.
Open System Settings, choose Help > MacBook Pro Specifications, then locate Display Support.

Connect a display or projector to your MacBook Pro. You can connect several different types of displays
and projectors to your MacBook Pro. If the display cable has a connector that doesn’t match the
Thunderbolt / USB 4 ports on your MacBook Pro, you can use an adapter (sold separately) to connect the
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display.

USB-C display: Connect the display to a Thunderbolt port on your MacBook Pro.

HDMI display: Plug a cable from your HDMI display directly into the HDMI port on your
MacBook Pro.

VGA display or projector: Use a USB-C VGA Multiport Adapter to connect the display or projector to
a Thunderbolt port on your MacBook Pro.

If the cable for your display has a connector that doesn’t match the port you want to use, you may be able to
use it with an adapter (sold separately). To learn more about adapters for your MacBook Pro, see Adapters for
your MacBook Pro and Adapters for the Thunderbolt or USB-C ports on your Mac.

To purchase an adapter, you can visit apple.com, your local Apple Store, or other resellers for more
information and availability. Review the display’s documentation or check with the display’s manufacturer to
make sure you choose the right product.

Note: The MacBook Pro can support both Apple Pro Display XDR and Apple Studio Display. To set up, see
the Apple Support articles Set up and use Apple Pro Display XDR and Set up and use Apple Studio Display.

Use Apple TV with AirPlay. If you have an HDMI display connected to Apple TV, you can use AirPlay to
mirror your MacBook Pro screen on your TV screen. See Stream content on a larger screen with AirPlay for
details.

After you have connected your display

Adjust and arrange displays. After you connect an external display or projector, go to System Settings and
click Displays in the sidebar to set how the displays are arranged, choose which to use as your main display,
and adjust resolution and refresh rate (Hz). If you increase the refresh rate for your display, you should select
a lower resolution for best performance.

If you want to mirror your screen, click the display that you want to act as a mirror, then choose the mirror
option from the “Use as” menu.

Use a display while MacBook Pro is closed. After you connect an external display to your MacBook Pro,
close the lid. You can continue to use your MacBook Pro with the connected display, as well as any
connected accessories. To connect an accessory, see Use accessories with your MacBook Pro.

Troubleshooting. To troubleshoot an issue with an external display, see If your external display is dark or
low resolution.

Get started with macOS

Set up your Mac

Set up your MacBook Pro

When you set up your new MacBook Pro, you can customize certain settings for your Mac, set up features
like Touch ID, and transfer data from another computer. If you already have a Mac, iPad, or iPhone, you may
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also have the option to skip several steps by using your existing settings in order to set up your new Mac
more quickly.

If you need additional support while setting up your Mac, you can speak with an Apple expert by chat, email,
on the phone, or set up an appointment at the Genius Bar. Learn more at Genius Bar Reservation and Apple
Support Options.

Setup Assistant walks you through the settings needed to start using your Mac. When setup is complete, see
When you’re done setting up your MacBook Pro for next steps.

If you’d like to walk through each step of the process, choose a link below.

If you’re new to Mac: See Set up your MacBook Pro for new Mac users.

If you’re already a Mac user: See Set up your MacBook Pro for current Mac users.

Set up your MacBook Pro for new Mac users

This walk-through covers each step of the setup process and is intended to be used alongside Setup Assistant.

Tip: Some steps may require you to scroll to select an option. If you’re not sure how to scroll on a Mac, just
slide two fingers up and down on your trackpad. If you’d like to adjust gestures later, learn how to do so with
MacBook Pro trackpad.

Before you begin

If you have an iPhone or iPad, keep these close at hand during setup, since some steps may require
verification on another device.

You have the opportunity to transfer data from another computer, like a Windows PC, during setup. If
you want to do this, make sure that you have the computer that you want to transfer data from, and that
it is updated to the latest available software version.

Setup Assistant makes setting up your MacBook Pro easy and shouldn’t take too long to complete. If
you choose to transfer data, however, set aside additional time.

Set your language, country or region, and connect to Wi-Fi

Choose your language. This sets the language for your Mac. To change the language later, open System
Settings, click General in the sidebar, click Language & Region, then choose your options.

Set your country or region. This sets the format of dates, currencies, temperature, and more for your Mac.
To change your country or region later, open System Settings, click General in the sidebar, click Language &
Region, then choose your options.

https://www.apple.com/retail/geniusbar/


Turn on Accessibility features. View accessibility options for Vision, Motor, Hearing, and Cognitive
abilities, or click Not Now. If you want to set up your Mac with VoiceOver, press the Escape button on your
keyboard. You can also triple-click Touch ID, the top right button on your keyboard, to view additional
accessibility options. To learn more, see Accessibility on your Mac.

Connect to a Wi-Fi network. Choose your Wi-Fi network and enter the password, if necessary. If youʼre
using Ethernet, you can also click Other Network Options and follow the onscreen instructions. You need an
additional Ethernet adapter to connect the Ethernet cable to the USB-C port on your MacBook Pro, such as
the Belkin USB-C to Gigabit Ethernet Adapter.

To change the Wi-Fi network later, open System Settings, click Wi-Fi in the sidebar, then choose a network
and enter the password, if necessary.

Note: During setup, you may be prompted to download the latest version of macOS. Follow the instructions
to install, then continue with the setup process.

Transfer information from another computer

You can migrate your data—like files, contacts, accounts, and more—from a Windows PC to your new Mac.
If you have another Mac you’d like to transfer from, see Transfer information from another Mac. You can
either transfer the data wirelessly, or you can connect your Windows PC to your MacBook Pro with an
Ethernet cable.
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Before you begin. Ensure that your Windows PC is updated to the latest available software version. Then
download Migration Assistant on your Windows PC. To download the right Migration Assistant for your
operating system, and to learn more about this process, see Transfer from PC to Mac with Migration
Assistant.

Transfer data wirelessly. Your Windows PC and your new Mac must be on the same Wi-Fi network. Click
your Windows PC on the setup screen and follow the instructions.

Transfer data later. You may also choose to not transfer data at this time. If so, click Not Now in the
Migration Assistant Window. To transfer data after setup, see Transfer your data to your new MacBook Pro.

Sign in to your Apple Account and set up your computer account

Sign in to your Apple Account. If you already have another Apple device, like an iPhone or iPad, you likely
have an Apple Account. If you don’t have an Apple Account, you can create one now (it’s free).

Your Apple Account consists of an email address and a password. It’s the account you use for everything you
do with Apple—including using the App Store, Apple TV app, iCloud, and more. Your Apple Account is not
the same as the username and password you use to sign in to your Mac computer account. To learn more, see
Apple Account on Mac.

Tip: It’s best to have your own Apple Account and not share it.

On this screen, do any of the following:

If you have an Apple Account: Enter your email address and password for your Apple Account. If you
have an iPhone or iPad, a verification code is sent to this device. If you don’t have an iPhone or iPad, a
verification code is texted to the phone number associated with your Apple Account. If you don’t
receive the verification code or you don’t receive the text, follow the onscreen prompts.

If you don’t have an Apple Account: Click “Create new Apple Account.”

https://support.apple.com/102565


If you have forgotten your Apple Account or password: Click “Forgot Apple Account or password.”

If you don’t want to sign in to or create an Apple Account at this time: Click Set Up Later. After setup,
you can sign in to an Apple Account or create a new Apple Account. Open System Settings, then click
“Sign in to your Apple Account” in the sidebar.

Note: After you’ve signed in to your Apple Account, read the terms and conditions. To accept, check the box,
then click Agree and proceed.

Create a computer account. Add your name, then create an account name and password, which can later be
used to unlock your MacBook Pro or approve other actions. You can add an optional hint to help retrieve
your computer account’s password if you forget it. To change your account’s login picture, click it, then
choose an option.

Note: Your computer account is not the same as your Apple Account. However, if you ever forget the
password to unlock your Mac and if you checked the option to allow your Apple Account to reset your user
account password during setup, you can use your Apple Account to reset the password.

Make this your new Mac

If you’ve already set up another device with iOS 15 or later or iPadOS 15 or later, a screen appears for
express setup, Make This Your New Mac. If you don’t have an iPhone or iPad with the right software
version, you do not see this step. (Not sure what software version is on your iPhone or iPad? See Find the
software version on your iPhone, iPad, or iPod.)

When you use Make This Your New Mac, you skip several of the setup steps by using the settings stored in
your iCloud account. To use your current settings, click Continue. The setup process jumps to Set up Touch
ID and Apple Pay.

If you want to customize your settings for your new MacBook Pro, click Customize Settings and proceed to
the next step.

https://support.apple.com/109065


Customize your Mac’s privacy and security settings, turn on Screen Time, and enable Siri

Enable Location Services. Choose whether to allow apps like Maps to use your Mac’s location. To change
your Location Services settings later, open System Settings, click Privacy & Security in the sidebar, then
click Location Services and choose your options.

If you don’t enable Location Services, you see a screen to choose your time zone.

Share analytics with Apple and Developers. Choose whether to send diagnostics and data to Apple, and
whether Apple can share crash and usage data with developers. To change these settings later, open System
Settings, click Privacy & Security in the sidebar, click Analytics & Improvements (you may need to scroll),
and choose options.

Set up Screen Time. Screen Time lets you see your daily and weekly usage of your MacBook Pro, set limits
on how long you can use certain apps, manage children’s screen time, and more. To turn on, click Continue;
otherwise click Set Up Later. If you choose to set up later, open System Settings and click Screen Time in the
sidebar to choose your options. For more options and details, see Screen Time on Mac.

Secure your data with FileVault. FileVault helps to keep your data secure. During setup, you can choose to
turn on FileVault to protect your data, and you can choose to allow your iCloud account to unlock your disk if
you forget your password. To learn more about FileVault and how to set it up later, see Encrypt Mac data with
FileVault.

Enable Siri and “Hey Siri.” You can turn on Siri and “Hey Siri” (so you can speak your Siri requests)
during setup. To set up Siri, click Enable Ask Siri. To set up “Hey Siri,” speak several Siri commands when
prompted. To turn on Siri and “Hey Siri” later, open System Settings, click Apple Intelligence & Siri in the
sidebar, and choose your options. To learn more about Siri, see Siri on your Mac.

You may also choose to share audio with Apple to improve Siri during setup. You can always change whether
or not to share audio later. Open System Settings, click Privacy & Security in the sidebar, click Analytics &
Improvements (you may need to scroll), and choose your options.

Set up Touch ID and Apple Pay

Set up Touch ID. You can add a fingerprint to Touch ID (the top-right button on your keyboard) during
setup, which you can use to unlock your MacBook Pro, authorize purchases with Apple Pay, and sign in to
some third-party apps. Follow the onscreen instructions to set up Touch ID. To set up Touch ID later, or to
add additional fingerprints, open System Settings, then click Touch ID & Password in the sidebar. To add a

fingerprint, click   and follow the onscreen instructions.

To learn more, see Use Touch ID on Mac.

Set up Apple Pay. If you set up Touch ID, you can set up Apple Pay and add a debit, credit, or store card that
can be used to make purchases with Touch ID. Enter your card details and follow the on-screen prompts. If
you already use a card for media purchases, you might be prompted to verify this card first.

To set up Apple Pay or add additional cards later, open System Settings, then click Wallet & Apple Pay.
Follow the onscreen prompts to set up Apple Pay.

Note: The card issuer determines whether your card is eligible to use with Apple Pay, and may ask you to
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provide additional information to complete the verification process. Many credit and debit cards can be used
with Apple Pay. For information about Apple Pay availability and current credit card issuers, see the
Apple Support article Apple Pay participating banks.

Set desktop appearance

Choose your look. Select Light, Dark, or Auto for your desktop appearance. Later, if you want to change the
choice you make during setup, open System Settings, click Appearance, then select an option. You can also
set other appearance settings, such as highlight color or sidebar icon size.

Note: If you choose to do express setup with Make This Your New Mac, you skip this step.

Setup is complete

Your new MacBook Pro is ready to go. See When you’re done setting up your MacBook Pro for next steps.

Set up your MacBook Pro for current Mac users

This walk-through covers each step of the setup process and is intended to be used alongside Setup Assistant.

Before you begin

Keep your other Mac, or your iPhone or iPad, close at hand during setup, since some steps may require
verification on another device.

You have the opportunity to transfer data from another Mac during setup. If you want to do this, make
sure that you have the computer that you want to transfer data from, and that it is updated to the latest
available software version.

Setup Assistant makes setting up your MacBook Pro easy and shouldn’t take too long to complete. If
you choose to transfer data, however, set aside additional time.

Set your language, country or region, and connect to Wi-Fi

Choose your language. This sets the language for your Mac. To change the language later, open System
Settings, click General in the sidebar, click Language & Region, then choose your options.

Set your country or region. This sets the format of dates, currencies, temperature, and more for your Mac.
To change the country or region later, open System Settings, click General in the sidebar, click Language &
Region, then choose your options.

https://support.apple.com/HT204916


Turn on Accessibility features. View accessibility options for Vision, Motor, Hearing, and Cognitive
abilities, or click Not Now. If you want to set up your Mac with VoiceOver, press the Escape button on your
keyboard. You can also triple-click Touch ID, the top right button on your keyboard, to view additional
accessibility options. To learn more, see Accessibility on your Mac.

Connect to a Wi-Fi network. Choose your Wi-Fi network and enter the password, if necessary. If youʼre
using Ethernet, you can also click Other Network Options and follow the onscreen instructions. You need an
additional Ethernet adapter to connect the Ethernet cable to the USB-C port on your MacBook Pro, such as
the Belkin USB-C to Gigabit Ethernet Adapter.

To change the Wi-Fi network later, open System Settings, click Wi-Fi in the sidebar, then choose a network
and enter the password, if necessary.

Note: During setup, you may be prompted to download the latest version of macOS. Follow the instructions
to install, then continue with the setup process.

Tip: After setup, if you don’t see the Wi-Fi status icon   in the menu bar, you can add it. Open System
Settings, click Control Center in the sidebar, then select “Show in Menu Bar” for Wi-Fi.

Transfer information from another Mac

You can migrate your data—like files, contacts, accounts, and more—from another Mac to your new
MacBook Pro. You may also choose to transfer information from a Time Machine backup or a startup disk
located on your Mac. When transferring from another Mac, you can either transfer the data wirelessly, or you
can connect your Mac to your MacBook Pro with an Ethernet cable.

If you’re restoring your Mac, see Restore your Mac from a back up.
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Before you begin. Ensure that the other Mac is updated to the latest available software version. Then open
Migration Assistant on the Mac that you are transferring from. Migration Assistant is located in the Utilities
folder of the Applications folder.

Transfer data wirelessly. Transfer information wirelessly from another Mac to your new Mac, if both
computers are near each other. Click your other Mac on the setup screen, and follow the instructions.

Transfer data using an Ethernet cable. Directly connect your MacBook Pro to the other Mac with an
Ethernet cable. You need an Ethernet adapter to connect the cable to the USB-C port on your MacBook Pro
such as the Belkin USB-C to Gigabit Ethernet Adapter. You may need an adapter to connect the Ethernet
cable to your other Mac, depending on its ports. After you connect them, click your other Mac on the setup
screen and follow the instructions.

Transfer data later. You may also choose to not transfer data at this time. If so, click Not Now in the
Migration Assistant Window. To transfer data after setup, see Transfer your data to your new MacBook Pro.

Learn more. To learn more about this process, see Transfer to a new Mac with Migration Assistant.

Sign in to your Apple Account and set up your computer account

Sign in to your Apple Account. When you sign in to your Apple Account during setup, you receive a
verification code on your other Apple devices. To proceed, enter the verification code on your new
MacBook Pro. If you don’t receive the code, or don’t have the device, you may choose to have the
verification code sent to you by text or phone call. If you can’t use the phone number associated with your
Apple Account, choose “Can’t use this number” and follow the onscreen instructions.

If you need to create an Apple Account, choose “Create new Apple Account.” If you have forgotten your
Apple Account or password, choose “Forgot Apple Account or password.”

If you don’t want to sign in to or create a new Apple Account now, click Set Up Later. After setup, you can
sign in to an Apple Account or create a new Apple Account. Open System Settings, then click “Sign in to
your Apple Account” in the sidebar.
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Note: After you’ve signed in to your Apple Account, read the terms and conditions. To accept, check the box,
then click Agree and proceed.

Create a computer account. Add your name and create an account name and password, which can later be
used to unlock your MacBook Pro or approve other actions. You can add an optional hint to help retrieve
your computer account’s password if you forget it. To change your account’s login picture, click it, then
choose an option.

Note: Your computer account is not the same as your Apple Account. However, if you ever forget the
password to unlock your Mac and if you checked the option to allow your Apple Account to reset your user
account password during setup, you can use your Apple Account to reset the password.

Make this your new Mac

If you’ve already set up another device with macOS 12 or later, iOS 15 or later, or iPadOS 15 or later, a
screen appears for express setup, Make This Your New Mac. If you don’t have a Mac, iPad, or iPhone with
the right software version, you don’t see this step. (Not sure what software version is on your Mac, iPhone, or
iPad? See Find out which macOS your Mac is using or Find the software version on your iPhone, iPad, or
iPod touch.)

When you use Make This Your New Mac, you skip several of the setup steps by using the settings stored in
your iCloud account. To use your current settings, click Continue. The setup process jumps to Set up Touch
ID and Apple Pay.

If you want to customize your settings for your new MacBook Pro, click Customize Settings and proceed to
the next step.

Customize your Mac’s privacy and security settings, turn on Screen Time, and enable Siri

Enable Location Services. Choose whether to allow apps like Maps to use your Mac’s location. To change
your Location Services settings later, open System Settings, click Privacy & Security in the sidebar, then
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click Location Services and choose your options.

If you don’t choose to enable location services, you see a screen to choose your time zone.

Share analytics with Apple and Developers. Choose whether to send diagnostics and data to Apple, and
whether Apple can share crash and usage data with developers. To change these settings later, open System
Settings, click Privacy & Security in the sidebar, click Analytics & Improvements (you may need to scroll),
then choose options.

Set up Screen Time. Screen Time lets you see your daily and weekly usage of your Mac, set limits on how
long you can use certain apps, manage children’s screen time, and more. To turn on Screen Time, click
Continue; otherwise click Set Up Later. If you choose to set up later, open System Settings, then click Screen
Time in the sidebar to choose your options. For more options and details, see Screen Time on Mac.

Secure your data with FileVault. FileVault helps to keep your data secure. During setup, you can choose to
turn on FileVault to protect your data, and you can choose to allow your iCloud account to unlock your disk if
you forget your password. To learn more about FileVault, and how to set it up later if you choose to not set up
now, see Encrypt Mac data with FileVault.

Enable Siri and “Hey Siri.” You can turn on Siri and “Hey Siri” (so you can speak your Siri requests)
during setup. To set up Siri, click Enable Ask Siri. To set up “Hey Siri,” speak several Siri commands when
prompted. To turn on Siri and “Hey Siri” later, open System Settings, click Apple Intelligence & Siri in the
sidebar, then choose your options. To learn more about Siri, see Siri on your Mac.

You may also choose to share audio with Apple to improve Siri during setup. You can always change whether
or not to share audio later. Open System Settings, click Privacy & Security in the sidebar, click Analytics &
Improvements (you may need to scroll), then choose your options.

Set up Touch ID and Apple Pay

Set up Touch ID. You can add a fingerprint to Touch ID, which you can use to unlock your MacBook Pro,
authorize purchases with Apple Pay, and sign in to some third-party apps. Follow the onscreen instructions to
set up Touch ID. To set up Touch ID later, or to add additional fingerprints, open System Settings, then click

Touch ID & Password in the sidebar. To add a fingerprint, click   and follow the onscreen instructions.

To learn more, see Use Touch ID on Mac.

Set up Apple Pay. If you set up Touch ID, you can set up Apple Pay and add a debit, credit, or store card that
can be used to make purchases with Touch ID. Enter your card details and follow the onscreen prompts. If
you already use a card for media purchases, you might be prompted to verify this card first.

To set up Apple Pay or add additional cards later, open System Settings, then click Wallet & Apple Pay.
Follow the onscreen prompts to set up Apple Pay.

Note: The card issuer determines whether your card is eligible to use with Apple Pay, and may ask you to
provide additional information to complete the verification process. Many credit and debit cards can be used
with Apple Pay. For information about Apple Pay availability and current credit card issuers, see the
Apple Support article Apple Pay participating banks.

Set desktop appearance
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Choose your look. Select Light, Dark, or Auto for your desktop appearance. Later, if you want to change the
choice you make during setup, open System Settings, click Appearance, then select an option. You can also
set other appearance settings, such as highlight color or sidebar icon size.

Note: If you choose to do express setup with Make This Your New Mac, you skip this step.

Setup is complete

Your new MacBook Pro is ready to go. See When you’re done setting up your MacBook Pro for next steps.

When you’re done setting up your MacBook Pro

After you’re done setting up your MacBook Pro, you can now start making it yours. Start to personalize your
Mac by setting up email and calendar accounts, adjusting text display by making text and other items on the
screen bigger, or customizing the desktop picture on your Mac. Learn how to seamlessly use your
MacBook Pro with other Apple devices with Work with multiple devices and Share content between devices.
If you’re interested in apps, learn more about how to work with apps or how to install new apps, including
iPhone and iPad apps that you have previously purchased, on your Mac with App Store. (Note that many, but
not all, iPhone and iPad apps are available on Mac.)

If you’re new to Mac, see Are you new to Mac? to learn some helpful tips. You may also find What’s it called
on my Mac? and the Apple Support article Mac tips for Windows switchers helpful. Whether you’re new to
Mac or looking for a refresher on macOS, learn more about getting started with your Mac and explore the
Desktop and menu bar, Finder, Dock, Control Center, and more.

Finally, you can get to know your new MacBook Pro. Learn more about the ports, built-in camera, and other
features of the hardware with Take a tour of MacBook Pro. Discover the capabilities of your Magic
Keyboard, learn and adjust gestures with Trackpad. You can also learn how to connect another display with
Use an external display or connect wireless accessories, like another keyboard or a mouse, with Use
accessories with your MacBook Pro.

Apple Account and iCloud

Apple Account on Mac

Your Apple Account lets you access all Apple services. Use your Apple Account to download apps from the
App Store; access media in Apple Music, Apple Podcasts, Apple TV, and Apple Books; keep your content up
to date across devices using iCloud; set up a Family Sharing group; and more.

You can also use your Apple Account to access other apps and websites (see Use Sign in with Apple on
Mac).

Important: If you forget your Apple Account password, you don’t need to create a new Apple Account. Just
click Forgot Password in the sign-in window to retrieve your password.

If other family members use Apple devices, make sure that each family member has their own
Apple Account. You can create Apple Accounts for your kids and share purchases and subscriptions with
Family Sharing, described later in this section.

To view the services you can use with your Apple Account, see the Apple Support article Where can I use my
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Apple Account?

All in one place. Manage everything related to your Apple Account in the same place. Open System Settings
on your MacBook Pro—your Apple Account and Family Sharing settings are at the top of the sidebar. To
sign in to your Apple Account, if you haven’t already, click “Sign in to your Apple Account” at the top of the
sidebar.

Update account, security, and payment information. In System Settings, click your Apple Account in the
sidebar, then select an item to review and update the information associated with your account.

Personal Information: Update your name, birthdate, and Memoji or photo associated with your
Apple Account. You can also set up your preferences for communication from Apple, and see how
your data is managed.

Sign-In & Security: Change your Apple Account password, turn on two-factor authentication, add or
remove phone numbers and emails you can use to sign in, and set up Account Recovery or Legacy
Contact. See Use Sign in with Apple.

Payment & Shipping: Manage the payment methods affiliated with your Apple Account, and your
shipping address for purchases from the Apple Store.

iCloud: Click iCloud, then choose which iCloud features you want to turn on. You can also turn on
iCloud+ features and manage your iCloud storage. When you turn on an iCloud feature, your content is
stored in iCloud, so you can access any content on any device with iCloud turned on and signed in with
the same Apple Account. To learn more about iCloud, see Use iCloud with your MacBook Pro, as well
as Apps and features that use iCloud and What is iCloud+?.

Media & Purchases: Manage the accounts linked to Apple Music, Apple Podcasts, Apple TV, and
Apple Books; select purchasing settings; and manage your subscriptions.
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Use the Passwords app. See all your passwords, passkeys, and verification codes in one place and across all
your devices. Sign in to iCloud with the same Apple Account and turn on Passwords in iCloud settings. See
Use passwords on Mac.

See all your devices. See all the devices linked to your Apple Account. You can verify that Find My [device]
is turned on for each one (see Find My), see the status of iCloud Backup for an iOS or iPadOS device, or
remove a device from your account if you no longer own it.

Family Sharing. With Family Sharing, you can set up a family group with up to six members. Then you can
share device locations or mark devices as lost in Find My. You can also manage how your children use their
devices by creating Apple Accounts for your kids and setting Screen Time limits (see Screen Time on Mac).

With Family Sharing, you can share subscriptions, including Apple TV+, Apple Music, iCloud+, and more.
You can also share purchases from the App Store, Apple TV app, Apple Books, and iTunes Store. Family
members can still use their own iCloud accounts. You can pay for family purchases with one credit card,
while approving your kids’ spending right from your MacBook Pro. To manage your Family Sharing settings,
click Family in System Settings. To learn more, see the Apple Support article Set up Family Sharing.

Learn more. To learn more about iCloud and Family Sharing, see Use iCloud with your MacBook Pro and
Manage a Family Sharing group on Mac.

Use iCloud with your MacBook Pro

With iCloud, you can keep your information up to date on all your devices, and collaborate with friends and
family. Your MacBook Pro works seamlessly with your iPhone, iPad, iPod touch, or Apple Watch when you
use iCloud and sign in to each of them with the same Apple Account.
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If you didn’t turn on iCloud when you first set up your Mac, open System Settings, then click “Sign in to
your Apple Account” in the sidebar. After you are signed in, click iCloud, then turn iCloud features on or off.
To learn more, see Set up iCloud features on Mac and Sign in to iCloud on all your devices.

Access your content across devices. With iCloud, you can securely store, edit, and share your documents,
photos, and videos across devices to make sure you’re always up to date. To get started, see Access your
iCloud content on your Mac.

Use your MacBook Pro with other devices. Seamlessly move content between your MacBook Pro and
other devices using Continuity. Just sign in to your Apple Account, and whenever your MacBook Pro and
devices are near each other, they work together in convenient ways. For instance, you can start a task on one
device and finish it on another, use your iPhone as a webcam for your MacBook Pro, stream your screen to
another Mac or Apple TV with AirPlay, set up your iPad to work side by side with your MacBook Pro using
Sidecar, and more. See Share content between devices, Work with multiple devices, and Stream content on a
larger screen with AirPlay.

For a list of system requirements for devices that support Continuity, see the Apple Support article System
requirements for Continuity features on Apple devices. To learn more about using Continuity with your
MacBook Pro, see the Apple Support article Use Continuity to connect your Mac, iPhone, iPad, and
Apple Watch or go to All your devices.

Do more with iCloud+. iCloud+ is a subscription service that gives you more space to store your photos,
files, and more. You can share your iCloud+ storage plan through Family Sharing. iCloud+ also includes
iCloud Private Relay, HomeKit Secure Video, and custom email domains for your Mail address on
iCloud.com. To learn more about what iCloud+ has to offer, see What is iCloud+?.

Access your iCloud content on your Mac

iCloud helps you keep your most important information—like your photos, files, notes, iCloud Keychain, and
more—safe, up to date, and available across all your devices. It’s built into every Apple device, and everyone
gets 5 GB of storage to start. (Purchases you make from the App Store, Apple TV app, Apple Books, or
iTunes Store don’t count toward your available space.)

So if you have an iPhone, iPad, or iPod touch, just sign in on each device with your Apple Account, turn on
iCloud, and you have everything you need. You can upgrade to iCloud+ if you need more storage and
premium features including iCloud Private Relay, Hide My Email, Custom Email Domain, and HomeKit
Secure Video support.

For system requirements about devices that support iCloud, see the Apple Support article System
requirements for iCloud.

Automatically store your desktop and Documents folder in iCloud Drive. You can save files in your
Documents folder or on your desktop, and they’re automatically available on iCloud Drive and accessible
wherever you are. When working with iCloud Drive, you have access to files on your MacBook Pro, on your
iPhone or iPad in the Files app, on the web at iCloud.com, or on a Windows PC in the iCloud for Windows
app. When you make changes to a file on a device or on iCloud Drive, you can see your edits wherever you
view the file.

To get started, open System Settings, click your Apple Account in the sidebar, click iCloud, then turn on
iCloud Drive. To learn more, see Set up and use iCloud Drive on all your devices. Also see the Apple
Support article Add your Desktop and Documents files to iCloud Drive.
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Store and share photos. Store your photo library in iCloud and see your photos and videos, as well as the
edits you make to them, on all your devices. To get started with iCloud Photos, go to System Settings, click
your Apple Account in the sidebar, click iCloud, then turn on Photos.  

Use iCloud Shared Photo Library to share photos and videos with up to five other people. Everyone can make
changes—like adding new content, making edits, or adding comments—to the shared library. Smart
suggestions make it easy to add particular photos from your collection, such as photos featuring a specific
person or taken on a certain date. To get started, go to Photos > Settings, click the Shared Library tab, and
follow the onscreen instructions. To learn more about iCloud Photos, see Use iCloud Photos on iCloud.com.

Enjoy your purchases anywhere. When you’re signed in to your devices with the same Apple Account,
purchases you’ve made on the App Store, Apple TV app, Apple Books, and iTunes Store are available at any
time, no matter which computer or device you used to purchase them. So all your music, movies, books, and
more are available wherever you go.

Locate your MacBook Pro with Find My Mac. If your MacBook Pro is missing and you have Find My
Mac turned on, you can use Find My to locate it on a map, lock its screen, and even erase its data remotely.
To turn on Find My Mac, open System Settings, click your Apple Account in the sidebar, click iCloud, click
Show All, then turn on Find My Mac. See the Apple Support article If your Mac is lost or stolen.

Note: If your MacBook Pro has multiple user accounts, only one can have Find My Mac turned on.

Learn more. See the iCloud User Guide and What is iCloud?.

Find your way around

Desktop and menu bar on your Mac

The first thing you see on your MacBook Pro is the desktop. The menu bar runs along the top of the screen,
and the Dock appears at bottom.
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Tip: Can’t find the pointer on the screen? To magnify it temporarily, move your finger rapidly back and forth
on the trackpad. Or if you’re using a mouse, slide it back and forth quickly.

Desktop. The desktop is where you do your work—whether it’s opening and using apps, working on files,
searching your MacBook Pro or the web with Spotlight, and more. To change your desktop picture, open
System Settings, click Wallpaper in the sidebar, then choose an option. You can also store files on your
desktop and keep them organized using stacks. To learn more about the desktop, including how to use stacks,
see Get to know the Mac desktop.

Menu bar. The menu bar runs along the top of the screen. Use the menus on the left side to choose
commands and perform tasks in apps. The menu items change, depending on which app you’re using. Use the

icons on the right side to connect to a Wi-Fi network, check your Wi-Fi status  , open Control Center 

, check your battery charge  , search using Spotlight  , and more.

Tip: You can change the icons that appear in the menu bar. See Control Center on your Mac.

help:anchor='mh40612'%20bookID='com.apple.machelp'


Apple menu  . The Apple menu contains frequently used items and always appears in the upper-left

corner of the screen. To open it, click the Apple icon  .

App menu. You can have multiple apps and windows open at the same time. The name of the app that’s

active appears in bold to the right of the Apple menu , followed by that app’s unique menus. If you open a
different app or click an open window in a different app, the name of the app menu changes to that app and
the menus in the menu bar change along with it. If you’re looking for a command in a menu and can’t find it,
check the app menu to see if the app you want is active.

Help menu. Help for your MacBook Pro is always available in the menu bar. To get help, open the Finder in
the Dock, click the Help menu, and choose macOS Help to open the macOS User Guide. Or type in the
search field and choose a suggestion. To get help for a specific app, open the app and click Help in the menu
bar. See Use the Mac User Guide.

Tip: You can add widgets from the widget gallery to your desktop, and even bring over widgets you have on
your iPhone—without having to install the corresponding app. To learn more see Manage windows on your
Mac.

Learn more. See Finder on your Mac and The Dock on your Mac.



Finder on your Mac

Represented by the blue icon with the smiling face, the Finder is the home base for your Mac. You use it to
organize and access almost everything on your Mac, including documents, images, movies, and any other

files you have. To open a Finder window, click  in the Dock at the bottom of the screen. Force click a file
icon to quickly view its contents, or force click a filename to edit it. See MacBook Pro trackpad to learn about
force clicking and other gestures.

Get organized. Your Mac has folders already created for common types of content—Documents, Pictures,
Applications, Music, and more. As you create documents, install apps, and do other work, you can create new
folders to stay organized. To create a new folder, choose File > New Folder. See Organize files in folders on
Mac.

Sync devices. When you connect a device like an iPhone or iPad, it appears in the Finder sidebar. Click the
device’s name to see options to back up, update, sync, and restore your device.

The Finder sidebar. The sidebar on the left shows the items you use often or want to open quickly. To see all
your documents stored on iCloud Drive, click the iCloud Drive folder in the sidebar. To see only the
documents that you’re sharing and that are shared with you, click the Shared folder. To change what’s shown
in the sidebar, choose Finder > Settings.

Change how you view files and folders. Click the pop-up menu button at the top of the Finder window to

change how you view documents and folders. View them as icons , in a list , in hierarchical

columns , or in a gallery . Both Gallery View and Column view show a large preview of your
selected file, so you can visually identify your images, video clips, and other documents. You can also make
quick adjustments, like rotating or marking up an image. To show the Preview pane options in the Finder,
choose View > Show Preview. To customize what’s shown, choose View > Show Preview Options, then
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select the options for your file type.

Tip: To show filenames in Gallery View, press Command-J and select “Show filename.”

To learn more about the different view options, see Change how folders are displayed in the Finder.

Quick Actions. In Gallery View or Column View, click  at the bottom right of the Finder window for
shortcuts to manage and edit files directly in the Finder. You can rotate an image, annotate or crop an image
in Markup, combine images and PDFs into a single file, trim audio and video files, run shortcuts created with
the Shortcuts app, and create custom actions through Automator workflows (for example, watermarking a
file). See Perform quick actions in the Finder on Mac.

Quick Look. Select a file and press the Space bar to open Quick Look. Use the buttons at the top of the
Quick Look window to sign PDFs; trim audio and video files; and mark up, rotate, and crop images without
opening a separate app. To learn more about Quick Look and markup features, see View and edit files with
Quick Look on Mac and Mark up files on Mac.

Tip: You can add alternative image descriptions that can be read by VoiceOver using Markup in Preview or
Quick Look.

Get there faster. The Go menu in the Finder menu bar is a quick way to get to folders and locations. Instead
of using several clicks to navigate to the Utilities folder, choose Go > Utilities. You can also choose Go >
Enclosing Folder to return to the top level of nested folders. If you know the path to a specific folder, choose
Go > Go to Folder, then type the path. See Go directly to a specific folder.
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The Dock on your Mac

The Dock, at the bottom of the screen, is a convenient place to keep the apps and documents you use
frequently.

Open an app or file. Click an app icon in the Dock, or click the Launchpad icon   in the Dock to see all

the apps on your Mac, then click the app you want. You can also search for an app using Spotlight  (in
the top-right corner of the menu bar), then open the app directly from your Spotlight search results. Recently
opened apps appear in the center section of the Dock.

Close an app. When you click the red dot in the top-left corner of an open window, the window closes but
the app stays open. Open apps have a black dot beneath them in the Dock. To close an app, Control-click the
app icon in the Dock and click Quit.

Add an item to the Dock. Drag the item and drop it where you want it. Place apps in the left section of the
Dock, and files or folders in the right section.

Remove an item from the Dock. Drag it out of the Dock. The item isn’t removed from your Mac—just from
the Dock.

See everything that’s open on your Mac. Press the Mission Control key  on your keyboard or swipe
with three fingers on your trackpad to open Mission Control. View your open windows, desktop spaces, full-

screen apps, and more, and switch easily between them. You can also add the Mission Control icon  to
the Dock. See See open windows and spaces in Mission Control on Mac.

See all open windows in an app. Force click an app in the Dock to view all the app’s open windows. To
Force click, click then press deeper.

Tip: Click Desktop & Dock in System Settings to change the appearance and behavior of the Dock. Make the
Dock larger or smaller, move it to the left or right side of the screen, set it to hide when you’re not using it,
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and more.

Learn more. See Use the Dock on Mac.

Notification Center on your Mac

Notification Center keeps all of your important information, reminders, and widgets in one convenient place.
Get details about calendar events, stocks, weather, and more—and catch up on notifications you might have
missed (emails, messages, reminders, and more).

Open Notification Center. Click the date or time at the top right of the screen, or swipe left from the right
edge of the trackpad with two fingers. Scroll down to see more.
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Interact with your notifications. Reply to an email, listen to the latest podcast, or view details about
calendar events. Click the arrow in the top-right corner of a notification to view options, take action, or get
more information.

Set your notification settings. Open System Settings, then click Notifications to select which notifications
you see, including whether you would like to see iPhone notifications on your Mac. Notifications are sorted
by most recent.

Pause notifications to focus on what you’re doing. When you’re working, having dinner, or just don’t want
to be disturbed, Focus can automatically filter your notifications so you see only the ones you specify. Focus
can pause all notifications or allow only certain ones to appear, and it can tell contacts that your notifications



are silenced using a status in Messages. To set up Focus, open System Settings, then click Focus in the

sidebar. To turn Focus on or off, click   in the menu bar, then click the Focus section and choose a Focus.

You can customize a Focus to fit what you’re currently doing, and allow notifications from certain people or
apps, for phone calls or upcoming events, and more. You can also share your Focus across devices and use
Focus filters to hide distracting content in apps like Calendar and Messages.

Customize your widgets. Click Edit Widgets (at the bottom of Notification Center) to see the widget gallery
and add, remove, or rearrange widgets. If you are signed in to the same Apple Account on your iPhone and
your Mac, you can also add your iPhone widgets to your desktop without having to install the corresponding
apps on your Mac. You can drag new widgets anywhere on your desktop or in Notification Center. You can
also add third-party widgets from the App Store.

Learn more. See Use Notification Center on Mac.

Control Center on your Mac

Control Center groups key settings for your Mac into a single place, giving you instant access to the controls
you use the most—like Bluetooth, AirDrop, Screen Mirroring, Focus, and brightness and volume controls—

right from the menu bar. Click  in the upper-right corner of the screen to open Control Center.

Click for more options. Click a button to see more options. For example, click the Wi-Fi button  to
see your preferred networks, other networks, or to open Wi-Fi Settings. To return to the main Control Center

view, click  again.

Manage your desktop. Use Stage Manager to automatically organize your apps and windows and quickly
switch between them. You can also group apps together to create workspaces ideal for your workflow. See
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Manage windows on your Mac.

Monitor your mic. When your computer’s microphone is in use, a recording indicator appears at the top of
Control Center. This indicator increases security and privacy on your Mac by letting you know if an app has
access to the microphone.

Pin your Control Center favorites. Drag a favorite item from Control Center to the menu bar to pin it there,
so you can easily access it with a single click. To change what appears in the menu bar, open System Settings,
click Control Center, then click the pop-up menu next to each item and choose “Show in Menu Bar.” You see
a preview of where the control will appear in the menu bar. Some items can’t be added to or removed from
Control Center or the menu bar.

Tip: To quickly remove an item from the menu bar, press and hold the Command key and drag the item out
of the menu bar.

Learn more. See Use Control Center on Mac. Also see Share content between devices and Stream content on
a larger screen with AirPlay.

Spotlight on your Mac

Spotlight   is an easy way to find anything on your MacBook Pro, such as images, documents, contacts,
calendar events, and email messages. You can also use Spotlight to open apps or perform quick actions, like
starting a Focus.
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Search for anything. Click   at the top right of the screen then start typing. You can also press the
Spotlight key (F4) on your keyboard. With Live Text, Spotlight can search for text in images (available in
select languages).

Tip: Press Command–Space bar to show or hide the Spotlight search field.

Open an app. Enter the app name in Spotlight, then press Return.

Perform quick actions. You can quickly do certain tasks with Spotlight, like running a shortcut, turning on
Do Not Disturb, or setting an alarm. Open Spotlight, then search for the action you want to perform.



Convert currencies, temperature, and measurements. Enter a currency—like $, €, or ¥—and an amount,
then press Return to get a list of converted values. Or specify a unit of measure for measurement conversions.

Narrow your search. You can include or exclude specific folders, disks, or types of information (such as
email or messages) from Spotlight searches. Click Spotlight in System Settings and go to “Search results,”
then select or deselect categories you want to include or exclude from your Spotlight results.

Use Siri Suggestions. Siri Suggestions offer info from Wikipedia articles, web search results, news, sports,
weather, stocks, movies, and other sources when you search with Spotlight.

If you want Spotlight to search only for items on your MacBook Pro, open System Settings, click Spotlight,
then deselect Siri Suggestions below “Search results.”

Learn more. See Search with Spotlight on Mac.

Siri on your Mac

Use Siri on your MacBook Pro to do everyday tasks and find information. For example, you can schedule
meetings, change settings, get answers, send messages, place calls, and add items to your calendar. If you
turn on the “Listen for” option in Siri settings, you can activate Siri with your voice when you say “Hey Siri”
or “Siri,” and immediately speak your request.

Throughout this guide, you can find examples of how you could use Siri—they look like this:

Siri: Say to Siri:

“How do I get home from here?”

“How high is Mount Whitney?”

“Create a new grocery list”
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“Show me my reminders.”

“What time is it in Paris?”

Note: To use Siri, your Mac must be connected to the internet. Siri may not be available in all languages or in
all areas, and features may vary by area.

Turn on Siri. Open System Settings, click Apple Intelligence & Siri in the sidebar, turn on Siri, then click

Enable. If you enabled Siri during setup, you can also press and hold the Dictation/Siri (F5) key  on your
keyboard to open Siri. You can customize other Siri settings, such as the language and voice to use and
whether to show Siri in the menu bar.

Tip: You can add the Siri icon to the menu bar by selecting that option in Control Center settings. Click 

or  to use Siri.

Hey Siri or Siri. On your MacBook Pro, you can simply say “Hey Siri” or “Siri” to get responses to your
requests. Open System Settings, click Apple Intelligence & Siri, click the pop-up menu next to “Listen for,”
then choose an option. Follow the onscreen instructions to finish setting up “Hey Siri” or “Siri.”

When this option is on and you turn on “Allow Siri when locked,” you can also use Siri even if your Mac is
locked or in sleep.

For convenience, Siri doesn’t respond when the lid to your MacBook Pro is closed. If the lid is closed and



connected to an external display, you can still activate Siri from the icon in the menu bar.

Activate Siri. Click  or  in the menu bar. You can also press and hold the Dictation/Siri key (F5) on
a Magic Keyboard, or use the keyboard shortcut selected in Siri settings.

Tip: To learn about more ways you can use Siri, ask “What can you do?” at any time, or see the Apple Siri
website.

Type to Siri. Type your requests to Siri instead of speaking them. Click Accessibility in System Settings,
then click Siri and turn on “Type to Siri.” If Apple Intelligence is turned on, you can automatically type Siri

requests—just click .

Show captions. Show what Siri says on screen. Open System Settings, click Apple Intelligence & Siri, then
click Siri Responses and turn on “Always show Siri captions.” You can also turn on “Always show speech”
to have Siri transcribe your requests. If Apple Intelligence is turned on, click Siri Responses and turn on
“Always show requests” to show what Siri says on the screen.

Change the voice. Open System Settings, click Apple Intelligence & Siri, then choose an option from the
Voice menu.

Learn more. See Use Siri on Mac and Get Started with Apple Intelligence.

Apple Intelligence is currently available in beta with Siri and device language set to U.S. English. Apple
Intelligence uses generative models, and outputs may be inaccurate, unexpected, or offensive. Check
important information for accuracy.

Customize your Mac

Add a personal touch

Make your MacBook Pro your own by changing the wallpaper, customizing your desktop, and more.

Change the wallpaper. Choose what your Mac looks like. Open System Settings, click Wallpaper, then
choose the wallpaper you want. You can select the same image as both your wallpaper and screensaver or
select a different image for each.
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Add widgets to your desktop. Keep your favorite apps front and center. Add a Photos widget to your
desktop to see photos from an album or a memory or add a Podcasts widget to keep your favorite shows on
queue. Click the date or time at the top right of the screen to open Notification Center, then click Add
Widgets to open the widget gallery to add, remove, or rearrange widgets. Drag new widgets anywhere on
your desktop or in Notification Center.

Make a Memoji. Create a Memoji to represent yourself across apps, including in the login window on your
Mac, as your Apple Account picture, and as your My Card in Contacts. Open System Settings, click Users &



Groups, click the picture next to your login name. Click Memoji, then click  to select and compose a
facial image. See Change your login picture and Create your Memoji in Messages.

Set up multiple desktops. Use Mission Control to set up multiple spaces to work and play in. To create a

space, enter Mission Control by pressing   on the top row of your keyboard and click the Add Desktop

button  . You can drag windows from one space to another and add or delete spaces as you work. See
Work in multiple spaces.

System Settings on your Mac

In System Settings, you can customize your MacBook Pro and adjust its settings to suit your needs. For
example, you can add a screen saver that can also become your wallpaper, manage notifications, change the
brightness or resolution with Display Settings, adjust Accessibility settings, and more. You can also
download the latest software update.

To start, click  in the Dock, or choose Apple menu  > System Settings, then click the setting in the
sidebar that you want to adjust. To see all settings in the sidebar, you may need to scroll down.

Tip: If you’re looking to adjust a particular setting, but aren’t sure where to find it, use the search field.
Results appear in the sidebar as you type.
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Lock your screen. You can set your MacBook Pro to turn off the display or start a screen saver after a period
of inactivity. You can also require a password in order to unlock the screen when you return to your Mac. To
set up, go to Lock Screen in System Settings.

Choose a screen saver. Slow-motion screen savers can turn your MacBook Pro display into a work of art,
both when you’re away from your Mac and as your wallpaper. To set up, go to Screen Saver in System
Settings. If you choose a Landscape, Cityscape, Underwater, Earth, or Shuffle Aerials screen saver, you can
also make it your wallpaper by turning on “Show as wallpaper.”

Customize Control Center and the menu bar. Choose which settings you want to appear in Control Center

 or in your menu bar. In System Settings, click Control Center in the sidebar, then choose your options.

Update macOS. In System Settings, click General, then click Software Update to see if your Mac is running
the latest version of macOS software. You can specify options for automatic software updates.

iCloud and Family Sharing settings. Sign in to iCloud with your Apple Account on your MacBook Pro,
manage how your apps use iCloud, and set up and manage Family Sharing. For more information, see Apple
Account on Mac and Use iCloud with your MacBook Pro.

Learn more. To learn more about System Settings, see Customize your Mac with System Settings.
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Display settings for your Mac

Match the light in your surroundings. Your MacBook Pro has True Tone technology. True Tone
automatically adapts the color of the display to match the light in your environment for a more natural
viewing experience. Turn True Tone on or off in the Displays settings in System Settings.

Use a dynamic desktop. When you use a dynamic desktop picture, the desktop picture automatically
changes to match the time of day in your location. Click Wallpaper in System Settings, then choose a picture
for Dynamic Desktop. To have your screen change based on your time zone, enable Location Services. If
Location Services is turned off, the picture changes based on the time zone specified in Date & Time settings.

Change how items appear on the screen. Change the display resolution to make everything on the screen
bigger, or increase the size of text and icons to make them easier to see. You can also make the pointer easier
to see or quickly locate it with a shake of your mouse. See Make text and other items on the screen bigger.

Stay focused with Dark Mode. You can use a dark color scheme for the desktop, menu bar, Dock, and all
the built-in macOS apps. Your content stands out front and center while darkened controls and windows
recede into the background. See white text on a black background in apps such as Mail, Contacts, Calendar,
and Messages, so it’s easier on your eyes when you’re working in dark environments.

Dark Mode is finely tuned for professionals who edit photos and images—colors and fine details pop against
the dark app backgrounds. But it’s also great for anyone who just wants to focus on their content.

Night Shift. Switch your Mac to warmer colors at night or in low-light conditions to reduce your exposure to
bright blue light. Blue light can make it harder to fall asleep, so warmer screen colors may help you get a
better night’s rest. You can schedule Night Shift to turn on and off automatically at specific times, or set it to
come on from sunset to sunrise. Open System Settings, click Displays, click the Night Shift button at the
bottom, then set your options. Drag the slider to adjust the color temperature.
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Connect a display. You can connect an external display, a projector, or a TV to your Mac. See Use an
external display with your MacBook Pro.

Learn more. See Displays settings on Mac and Change Display settings for accessibility.

Screen Time on Mac

Screen Time shows how you spend time on your MacBook Pro, provides tools to make it easy to step away
during downtime, and lets you monitor what your kids are doing on their Apple devices.

See how you use your MacBook Pro. View reports to see how much time you’re spending with apps and
websites during a single day or across a week, find out which apps notify you the most, and see how often
you pick up your device each day. Open System Settings, choose Screen Time in the sidebar, then click App
& Website Activity, Notifications, or Pickups. You may need to turn on Screen Time before these options
appear.

Set your limits. Set limits to control how much time you spend with specific apps, categories of apps, and
websites. In Screen Time, choose Downtime, turn on Downtime, then click the Schedule pop-up menu to
create a daily schedule or a custom one for every day of the week.

Manage your kid’s screen time. Parents can configure Screen Time on their Mac—or iPhone or iPad—and
everything is set up for their kids on their devices. You can also set age-based media ratings for the Music
and Books apps. See Set up Screen Time for a child on Mac to learn more.

Don’t miss the important things. Choose which apps or website you always need access to. In Screen Time,
choose Always Allowed, then turn on the apps that you want to remain available during downtime.
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Learn more. See Manage downtime in Screen Time and Set up content and privacy restrictions in Screen
Time.

Accessibility on your Mac

Your Mac includes accessibility tools that make Apple features available and easy to use by anyone. To
access these tools, open System Settings, then click Accessibility in the sidebar. Accessibility settings are
grouped into five categories:

Vision: Zoom in on the screen, make the pointer bigger, apply color filters, and more.

Hearing: Show and customize captions on the screen, pair hearing devices, make Real-Time Text
(RTT) calls, get live captions of audio, set accessibility options for AirPods, and more.

Mobility: Control your Mac and apps using spoken commands, keys on your keyboard, an onscreen
keyboard, facial expressions, or assistive devices.

Speech: Type what you want to say and have it spoken out loud. You can also create a personal voice.

General: Customize your keyboard shortcuts to quickly turn accessibility features on or off.

Accessibility features for vision

Use VoiceOver, the built-in screen reader. VoiceOver describes aloud what appears on the screen and
speaks the text in documents, webpages, and windows. Using VoiceOver, you control your Mac with the
keyboard or trackpad gestures. You can also connect a refreshable braille display to use with VoiceOver.

To turn on VoiceOver, do any of the following:

Press Command-F5. If VoiceOver is on already, pressing the keys turns it off.

Use Siri. Say something like: “Turn VoiceOver on” or “Turn VoiceOver off.”

Choose Apple menu  > System Settings, then click Accessibility in the sidebar (you may need to
scroll down). Click VoiceOver, then turn VoiceOver on or off.

Learn more about VoiceOver, including how to customize it to fit your needs.

Adjust your View with Zoom. You can zoom in on part or all of the screen. If you have more than one
monitor, you can keep one zoomed in tightly and another at its standard resolution. To change zoom settings,

choose Apple menu  > System Settings, click Accessibility in the sidebar, then click Zoom.

Zoom in on words with Hover Text. In System Settings, click Accessibility, click Zoom, then turn on Hover
Text at the bottom. Press Command while holding the pointer over the text, and a window with zoomed text
appears on your screen.
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Adjust your Mac display colors. You can adjust your Mac display colors using color filters. To change these
settings, go to System Settings, click Accessibility in the sidebar, click Display, then turn color filters on or
off. To quickly turn color filters on or off, press Option-Command-F5; if your Mac or Magic Keyboard has
Touch ID, press Touch ID quickly three times.

Learn more about accessibility features for vision.

Accessibility features for hearing

Add captions in real time. With Live Captions, you can add real-time captions for conversations, audio, and
video. See Use Live Captions.

Important: Live Captions is not available in all languages, countries, or regions. The accuracy of Live
Captions may vary and should not be relied upon in high-risk or emergency situations.

Use hearing devices. Pair Made for iPhone (MFi) hearing aids or sound processors directly to your Mac to

stream audio and adjust their settings. To pair devices, choose Apple menu  > System Settings, click
Accessibility in the sidebar, then click Hearing Devices. See Use hearing devices with your Mac.

Customize your AirPods. Amplify soft sounds and adjust certain frequencies to help music, movies, phone
calls, and podcasts sound more crisp and clear by setting accessibility options for AirPods. See Set
headphone accommodations for AirPods.

Mask unwanted noise. Mask unwanted environmental noise and minimize distractions with calming sounds

like ocean or rain. To turn on background sounds, choose Apple menu  > System Settings, click
Accessibility in the sidebar, then click Audio and turn on Background sounds. Choose from a variety of
sounds, then drag the slider to increase or decrease the volume of the background sound.
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Learn more about accessibility features for hearing.

Accessibility features for mobility

Control your Mac with your voice. With Voice Control, you can perform a wide range of actions with your
voice. All audio processing for Voice Control happens on your Mac, so your personal data is kept private. To

turn on Voice Control, choose Apple Menu  > System Settings, click Accessibility in the sidebar, then
click Voice Control.

Customize your pointer. Customize the outline and fill color of the mouse pointer so it’s easier to recognize
when it moves or changes shape.

Improved keyboard access. An expanded set of keyboard shortcuts allows you to control everything on
your Mac with a keyboard—no mouse or trackpad required.

Learn more about accessibility features for mobility.

Accessibility features for speech

Have your Mac speak for you. With Live Speech, you can type what you want to say and have it spoken out
loud during phone and FaceTime calls, as well as in-person conversations. Save commonly used phrases to
chime in quickly during a conversation. You can choose a voice to use or record a Personal Voice. See Create
a Personal Voice.

Use Vocal Shortcuts. Set up your Mac to perform an action when you speak a word or another sound of your

choosing. To use Vocal Shortcuts, choose Apple menu  > System Settings, click Accessibility, go to
Speech, then click Vocal Shortcut. See Use Vocal Shortcuts.
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Have Siri listen for atypical speech. If you have an acquired or progressive condition that affects speech,
have Siri recognize a wider range of atypical speech patterns. See Change Siri settings for accessibility.

Learn more about accessibility features for speech.

Learn more. See Get started with accessibility features on your Mac and the Apple Accessibility website.

Manage windows on your Mac
It’s easy to find yourself with a dozen open apps and one or more windows for each app open on your
desktop. Luckily, there are some efficient ways to see and navigate the windows you have open. When you
want to focus, you can expand one app to fill the whole screen, choose two apps to share the screen, or lay
out a custom workspace. Automatically organize your apps and windows with Stage Manager to keep your
desktop clutter-free and quickly move between tasks. When you need to find a window that’s buried, use
Mission Control to show all your open windows in a single layer. You can use multiple desktop spaces to
spread out your work on different desktops and easily move between them.

Use the whole screen. Use full-screen view to focus on one app. In full screen, the menu bar is hidden until
you move the pointer to the top of the screen, or you can choose to always show the menu bar. To enter or
leave full-screen view, move the pointer over the green button in the top-left corner of the window, then
choose Full Screen from the menu that appears. See Use apps in full screen.

Split the screen. Use Split View to work in two app windows side by side. Move the pointer to the green
button in the top-left corner of a window you want to use, click Full Screen, then choose Right of Screen or
Left of Screen to position your window. Click another window and it automatically fills the other half of the
screen. Hold the pointer over the green button to see the options to switch apps, take the two windows to full
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screen, and more. See Use apps in Split View.

Tile windows. Move and resize windows or arrange windows to fill your screen. Move the pointer to the
green button in the top-left corner of a window you want to use, then choose how you want to arrange your
screen. See Tile windows.

Tip: If you want to get a clear view of your desktop when you have multiple windows open, click anywhere
on the desktop wallpaper to quickly move any open windows to the side. Click the desktop wallpaper again
to reopen your windows when you’re ready to resume the task at hand.

Widgets. Place widgets on your desktop from the widget gallery so you have access to your frequently used
apps when you need them. Click the date and time in the menu bar or Control-click the desktop, then click
Edit Widgets to add, remove, or rearrange widgets. You can drag new widgets anywhere on your desktop or
in Notification Center. If you are signed in with the same Apple Account on your iPhone and your Mac, you
can also add your iPhone widgets to your desktop without having to install the corresponding apps on your
Mac.
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Stage Manager. Automatically organize your apps and windows so your desktop stays clutter-free. What you
want to focus on is front and center with your other windows arranged on the side and accessible with a
single click. Open Control Center, then click Stage Manager. See Organize your Mac desktop with Stage
Manager.

Mission Control. Quickly move your open windows into a single layer, then click a window to return to
regular view with that window in front and active. If you have additional desktops (spaces) or have apps in

Split View, they appear in a row along the top of the screen. To enter or leave Mission Control, press 
on the top row of your keyboard, or press Control-Up Arrow. You can also add the Mission Control icon 

 to the Dock. See See open windows and spaces in Mission Control.

When one desktop isn’t enough. Organize your app windows into multiple desktop spaces, then switch

between them as you work. To create a space, enter Mission Control and click . Use keyboard shortcuts
and Mission Control to move between your spaces. You can drag windows from one space to another and add
or delete spaces as you work. See Work in multiple spaces.

That horizontal traffic light. The red, yellow, and green buttons in the top-left corner of every window
aren’t just for show. Click the red button to close an app window. For some apps, this quits the app and closes
all open windows for the app. For others, it closes the current window but leaves the app open. The yellow
button closes the window temporarily and puts it in the right side of the Dock. When you want to reopen the
window, click it in the Dock to expand it. And the green button is a quick way to change your windows to full
screen and Split View, and more.

Take a screenshot on your Mac
Explore the Screenshot menu to find all the controls you need to take screenshots and screen recordings. You
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can also capture your voice during a screen recording. The optimized workflow lets you take photos and
videos of your screen, and then easily share, edit, or save them.

Access the screenshot controls. Press Command-Shift-5. You can capture the entire screen, a selected
window, or a portion of a window. You can also record the entire screen or a selected portion of the screen.

Use the icons at the bottom of the screen to capture a selection , record your screen , and more.
Click Options to modify your save location, set a timer before capturing, set microphone and audio options,
or show the pointer. Click Capture or Record to take the screenshot or video.

After you take a screenshot or video, a thumbnail appears in the corner of the screen. Drag the thumbnail into
a document or folder, swipe to the right to quickly save it, or click to edit or share it.

Note: You can also open the Screenshot utility from the Other folder in Launchpad, or go to the Apps >
Utilities folder in the Finder.

Mark up your screenshot. Click the thumbnail of your screenshot to use Markup tools and make

annotations. You can also click  to send your marked-up screen to colleagues or friends—right from the
screenshot itself. See Mark up files on Mac.

Learn more. See Take screenshots or screen recordings on Mac.

Back up, restore, and transfer your data

Transfer your data to your new MacBook Pro
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You can transfer your files and settings from another Mac or PC to your new MacBook Pro. The first time
you start your new MacBook Pro, you’re asked if you want to transfer data from another computer. For more
information about transferring data during the setup process, see Set up your MacBook Pro. If you want to
transfer data from a new computer now, you can use one of the options below.

Before you begin

Upgrade both your previous computer and new computer to the latest version of the operating system.
For more information about how to update your Mac based on your current operating system, see Keep
your Mac up to date. Be sure to use the menu at the top of the page to choose your current operating
system and get the most accurate instructions.

To transfer your data wirelessly, make sure both computers are connected to same network.

Transfer data from another Mac

Use Migration Assistant to transfer your data over a wired or wireless network, or by connecting your old and
new computers with an Ethernet cable. On both Macs, open a Finder window, go to Applications, open the
Utilities folder, then double-click Migration Assistant and follow the onscreen instructions. If you are
transferring wirelessly, keep the computers near each other throughout the migration process. See the Apple
Support article Transfer to a new Mac with Migration Assistant.

Transfer data from a PC

Use Windows Migration Assistant to transfer your data over a wired or wireless network. See the Apple
Support article Transfer from PC to Mac with Migration Assistant to find the correct version of Migration
Assistant for your Windows PC.

Transfer data from a storage device

Connect the storage device to your MacBook Pro using an appropriate adapter if necessary (see Adapters for
your MacBook Pro). Then, see Transfer your information to Mac from another computer or device for next
steps.

Transfer data from a Time Machine backup

If the content on your previous computer’s hard disk was damaged, and you need to restore it from a Time
Machine backup, you can use Migration Assistant to do so. See Back up and restore.

Learn more. See Transfer your information to Mac from another computer or device.

Back up and restore your Mac

It’s important to back up your MacBook Pro regularly to keep your files safe. You can back up your apps,
accounts, settings, music, photos, movies, and documents using Time Machine, which is built into your Mac.
Time Machine doesn’t back up the macOS operating system.

Decide where you want to back up your files. Time Machine can back up to an external storage device
connected to your MacBook Pro, as well as other supported storage devices. For a list of devices supported
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by Time Machine, see the Apple Support article Backup disks you can use with Time Machine.

Set up Time Machine. Before you begin, consult the documentation that came with your storage device, and
make sure your MacBook Pro is on the same Wi-Fi network as your external storage device, or connect the
external storage device to your MacBook Pro with a cable, using an appropriate adapter if necessary (see
Adapters for your MacBook Pro). Open System Settings, click General > Time Machine, then click Add
Backup Disk. Select the drive you want to use for backup, and you’re all set.

Restore your files. You can use Time Machine  to restore your files, and choose to restore only some
files or all of them at once. Click the Time Machine icon in the menu bar, then choose “Browse Time
Machine backups.” Select one or more items that you want to restore (individual folders or your entire disk),
then click Restore.

Note: If the Time Machine icon isn’t in the menu bar, choose Apple Menu  > System Settings, then click
Control Center in the sidebar. Click the pop-up menu next to Time Machine, then choose Show in Menu Bar.

Reinstall macOS. Your operating system files are kept separate from your personal files in a sealed system
disk. However, some actions, like erasing or inadvertently damaging a disk, require that you restore your
MacBook Pro. You can reinstall macOS and then use Time Machine to restore your personal files from your
backup. With macOS Big Sur and later, there are several ways to restore your Mac. You may be required to
install a newer version of macOS than what your computer originally came with, or what you were using
before the disk was damaged. To learn more about these options, see Recover all your files from a Time
Machine backup and the Apple Support article How to reinstall macOS.

Important: Advanced users may want to create a bootable installer to reinstall macOS in the future. This can
be useful if you want to use a specific version of macOS. See the Apple Support article How to create a
bootable installer for macOS.

Learn more. See Back up your files with Time Machine and Time Machine troubleshooting on Mac. Also
see the Apple Support article What to do before you sell, give away, or trade in your Mac.

Use MacBook Pro with other devices

Share content between devices
There are lots of ways to share content between Apple devices. Use AirDrop to share files, photos, passwords
and more, or copy and paste between devices using Universal Clipboard.

Share files and more with AirDrop
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AirDrop makes it easy to share files with nearby Mac, iPhone, iPad, and iPod touch devices. The devices
don’t need to share the same Apple Account.

Turn on AirDrop. Click  in the menu bar, then click AirDrop . Select “Contacts only” or
“Everyone” to control who can AirDrop content to you.

Send a file from the Finder. Control-click the item you want to send, choose Share > AirDrop, then select

the device you want to send the item to. Or click  in the Dock, then click AirDrop in the sidebar on the
left. When the person you want to send a file to appears in the window, drag the file to them from the desktop
or another Finder window. When you send a file to someone, the recipient can choose whether or not to
accept the file.

Send a file from an app. While using an app like Pages or Preview, click  and choose AirDrop, then
select the device you want to send the item to.

Tip: If you don’t see the recipient in the AirDrop window, make sure both devices have AirDrop and
Bluetooth turned on and are within 30 feet (9 meters) of each other. If the recipient is using an older Mac, try
clicking “Don’t see who you’re looking for?”

Receive items using AirDrop. When someone uses AirDrop to send an item to you on your Mac, you can
choose whether to accept and save it. When you see the AirDrop notification and want the item, click Accept,
then choose to save it to your Downloads folder or an app like Photos. If you’re signed in on several devices
with the same iCloud account, you can easily send an item (for example, a photo from iPhone) from one
device to another, and it’s saved automatically.

Learn more. See Use AirDrop on your Mac to send files to devices near you and the Apple Support article
Use AirDrop on your Mac.
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Use Handoff on your Mac

With Handoff, you can continue on one device where you left off on another. Start a FaceTime call on your
iPhone, then transfer the call to your MacBook Pro when you get back to your desk. Or work on a
presentation on your MacBook Pro, then continue on your iPad. Handoff works with FaceTime, Safari, Mail,
Calendar, Contacts, Maps, Messages, Notes, Reminders, Keynote, Numbers, and Pages.

Turn on Handoff on your MacBook Pro. Open System Settings, click General in the sidebar, click Airdrop
& Handoff, then select “Allow Handoff between this Mac and your iCloud devices.”

Turn on Handoff on your iOS or iPadOS device. Go to Settings > General > Handoff, then tap to turn on
Handoff. If you don’t see the option, your device doesn’t support Handoff.

Turn on Handoff on your Apple Watch. In the Apple Watch app on iPhone, go to Settings > General, then
tap to turn on Enable Handoff.

Hand off actions between devices. For most activities, when your MacBook Pro and other devices are near
each other, an icon appears in the Dock when that activity can be handed off. Click the icon to hand off
between your devices.

For FaceTime, if you want to hand off a call from your iPhone or iPad to your MacBook Pro, click  in
the menu bar on your Mac, click Switch, then click Join in the FaceTime window on your Mac. To hand off a

FaceTime call from your MacBook Pro to your iPhone or iPad, tap  in the upper left of your iPhone or
iPad, tap Switch, then tap Switch again.

Learn more. See Pick up where you left off with Handoff.

Copy and paste between devices
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Copy content from one device, and paste it to another nearby device within a short period of time. The
contents of your Clipboard are sent over Wi-Fi and made available to all Mac, iPhone, iPad, and iPod touch
devices that are signed in to the same Apple Account and have Handoff, Wi-Fi, and Bluetooth turned on.

Learn more. See Copy and paste between devices from your Mac.

Use your iPhone to take photos on your Mac
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Continuity Camera on your Mac lets you use your iPhone as an additional camera for your Mac. You can use
your iPhone camera to take photos to insert them into documents or save them to your Mac.

Insert an image or scan. Use the camera on your iPhone, iPad, or iPod touch to scan documents or take a
picture of something nearby. The image appears instantly on your Mac. In an app like Mail, Notes, or
Messages, select where you want the image to go, choose File (or Insert) > Import From iPhone or iPad,
choose Take Photo or Scan Documents, then take the photo or scan the image on your iOS or iPadOS device.
Tap Use Photo or Keep Scan. You can also tap Retake if you want to try again.

In an app such as Pages, select where you want the image to be inserted, then Control-click, choose “Import
image,” and take the photo. You might need to select your device before taking the photo.

Note: To take a scan on your iOS or iPadOS device, drag the frame until what you want to show is in the
frame, tap Keep Scan, then tap Save. Tap Retake to rescan the content.

The photo or scan appears where you want it in your document.

Learn more. See Use your iPhone as a webcam and Insert photos and scans with Continuity Camera on Mac.

Stream content on a larger screen with AirPlay
Use AirPlay to stream whatever’s on your MacBook Pro on the big screen—or use AirPlay to send content to
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your Mac from an iPhone, iPad, or even another Mac. You can mirror the MacBook Pro screen on your high-
resolution TV screen or use the high-resolution TV as a second display. To do so, connect your TV to
Apple TV and make sure Apple TV is on the same Wi-Fi network as your MacBook Pro. You can also play
web videos directly on your high-resolution TV without showing what’s on your desktop—handy when you
want to play a movie but keep your work private.

Send content to your Mac from other devices. Watch videos, listen to music, and more on your Mac as
they’re being played on your other devices. Mirror your iPhone or iPad on your Mac or extend its display by
using your Mac as a secondary display for apps that support it, such as Keynote and Photos. Use your Mac as
an AirPlay 2 speaker to stream music or podcasts to your Mac, or use it as a secondary speaker for multiroom
audio. Your Mac works with any Apple device, and it’s even easier to connect if the devices share the same
Apple Account.

Mirror your desktop using Screen Mirroring. Click  in the menu bar, click , then choose your
Apple TV. When AirPlay is active, the icon turns blue.

Note: If your Mac supports AirPlay screen mirroring, you see an AirPlay status icon in the menu bar when an
Apple TV is on the same network as your Mac. See Stream audio and video from your Mac with AirPlay.

Play web videos without showing your desktop. When you find a web video with an AirPlay icon  ,
click the icon, then select your Apple TV.

Apple TV is sold separately at apple.com or your local Apple Store.

Tip: If the image doesn’t fit your high-resolution TV screen when you mirror the screen, adjust the desktop

size for the best picture. Click   in the video, then choose an option under Match Desktop Size To.

Learn more. To learn more about AirPlay, see Use AirPlay to stream what’s on your Mac to an HDTV. To
learn more about using a second display with your MacBook Pro, see Use an external display with your
MacBook Pro. To troubleshoot, see the Apple Support article If screen mirroring or streaming isn’t working
on your AirPlay-compatible device.

Work with multiple devices
Your Mac works with your other Apple devices. Continuity lets you unlock powerful capabilities when you
use Mac, iPad, iPhone, or Apple Watch together.

Before you begin. Make sure your MacBook Pro and iOS or iPadOS device have Wi-Fi and Bluetooth turned
on and are signed in to the same Apple Account.

Use your iPhone with your Mac
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Add iPhone widgets to your desktop. Put your iPhone widgets directly on your Mac desktop. Use the
Widget Gallery to select iPhone widgets for your Mac or drop widgets from Notification Center onto your
desktop. To open the Widget Gallery, Control-click the desktop, then select Edit Widgets.

Use your iPhone as a webcam. Continuity Camera on your Mac lets you use your iPhone as an additional
camera for your Mac. You can use your iPhone camera to make video calls. After you set up Continuity
Camera, your Mac can automatically switch to using iPhone as a camera when it is in range. You can also use
a wired connection if you prefer. See Choose an external camera and Use your iPhone as a webcam.

Note: To use Continuity Camera as a webcam requires an iPhone XR or newer. To use Continuity Camera to
share photos, you need an iPhone or iPod touch with iOS 12 (or later) or an iPad with iPadOS 13.1 (or later)
installed.

Use your iPhone microphone. With Continuity Camera, you can use your iPhone as a microphone for your
Mac. Use the Video menu in FaceTime to select your iPhone during a call, or use app settings to switch to
your iPhone’s microphone during video calls. You can also use Audio settings in System Settings to select
your iPhone as your system microphone.

Use iPhone apps on Mac. Many of your favorite iPhone and iPad apps work on your Mac. See Use iPhone
and iPad apps on Mac with Apple silicon.

Phone calls and text messages on Mac. With a Wi-Fi connection, you can take calls—and make them—
right from your MacBook Pro. You can also receive and send text messages.

On your iPhone, go to Settings > Phone and enable Wi-Fi calling. Then, on your Mac, open FaceTime. Go to
Settings, choose General, then click “Calls from iPhone.” See Set up your iPhone and Mac for phone calls.

Use your iPhone as a Hotspot. Lost your Wi-Fi connection? With Instant Hotspot, you can use the Personal
Hotspot on your iPhone or iPad to connect your MacBook Pro to the internet instantly—no password
required. See Use an iPhone or iPad to connect to the Internet.
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Click  in the menu bar, then click   next to your iPhone or iPad in the list (if you don’t see the

list, click Other Networks). The Wi-Fi icon in the toolbar changes to  . You don’t need to do anything
on your device—MacBook Pro connects automatically. When you’re not using the hotspot, your
MacBook Pro disconnects to save battery life.

Tip: If you’re asked for a password, make sure your devices are set up correctly. See the Apple Support
article Use Instant Hotspot to connect to your Personal Hotspot without entering a password.

Use your iPad with your Mac

Get even more out of MacBook Pro by using it with your iPad. Sidecar lets you use your iPad as a second
display for your Mac — giving you extra space to spread your work out and draw in your favorite Mac apps
with Apple Pencil. With Universal Control, you can also control your iPad with your Mac keyboard and
mouse or trackpad, making it easy to move content between iPadOS and macOS. Plus you can quickly
markup screenshots, PDFs, and more.

Use your iPad as another display for your Mac. With Sidecar, you can use your iPad wirelessly within 32
feet (ten meters) of your Mac, or you can connect your iPad to your Mac with a cable to keep it charged.

Set up Sidecar. Choose Apple menu   > System Settings, click Displays, then choose your iPad from the
Add Display pop-up menu.

Connect and disconnect from your iPad. To connect your iPad, click , click , then click the name

of your iPad. To disconnect from your iPad, click  in Control Center or tap   in the sidebar of your
iPad.

Set Sidecar settings. Open System Settings, click Displays, then click the name of your iPad. You can then
specify Sidecar settings for your iPad, such as whether it is the main display or mirrors your Mac, whether it
shows the sidebar and where it is located, and if you can double-tap with Apple Pencil to access tools.

Note: If you haven’t set up your iPad, you don’t see these options in Display settings.

Use Apple Pencil. Precisely draw and create in your favorite pro apps. Just drag the window from your Mac
to your iPad and start using Apple Pencil. Or use Apple Pencil to mark up PDFs, screenshots, and images. To
learn more, see Insert sketches with Continuity Sketch and the Apple Support article Use Markup on your
iPhone, iPad, or iPod touch.

Note: Pressure and tilt for Apple Pencil only work in apps with advanced stylus support.

Extend or mirror your desktop. When you connect your iPad, it automatically becomes an extension of
your Mac desktop, so you can drag your apps and documents between your Mac and iPad. To show your Mac

screen on both devices (mirror the display), move your mouse over the Sidecar button  in
Control Center, click the right arrow that appears above the button, then select Mirror Built-in Retina Display.
To extend your desktop again, open the menu and choose Use As Separate Display.

Take advantage of sidebar shortcuts. Use the sidebar on your iPad to quickly reach commonly used buttons
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and controls. Tap the buttons to undo actions, use keyboard shortcuts, and display or hide the menu bar,
Dock, and keyboard.

Tip: For quick access to the Sidecar options, you can set Display settings  to always appear in the menu
bar. Go to System Settings > Control Center, then use the pop-up menu next to Displays to select whether to
show the Displays icon in the menu bar all the time or only when active. When Sidecar is on and your iPad is

connected, the Display icon in the menu bar changes to .

Use a single keyboard and mouse or trackpad to control multiple devices. With Universal Control, you
can use a single keyboard and a mouse or trackpad to control multiple devices. When you move the pointer to
the edge of your MacBook Pro screen, the pointer moves to your iPad or another Mac, so you can work
across up to three devices.

Before you begin. To use Universal Control on your Mac, make sure each device has Bluetooth turned on
and is connected to Wi-Fi. Also make sure Handoff is turned on in General settings on your MacBook Pro
and in Settings > General > AirPlay & Handoff on your iPad. You must also be signed in with the same
Apple Account on both devices, and have two-factor authentication turned on. When these settings are
correct, you can use Control Center to connect your devices. On your Mac, click Control Center in the menu
bar, click Screen Mirroring, then choose a device below Link Keyboard and Mouse.

Move between screens. On your Mac, use your mouse or trackpad to move the pointer to the right or left
edge of the screen closest to your iPad, pause, then move the pointer slightly past the edge of the screen.
When a border appears at the edge of the iPad screen, continue moving the pointer to the iPad screen.

Drag and drop. Select the text, image, or other object you want to move, then drag it to where you want it on
your other device. For example, you can drag a sketch you drew with Apple Pencil from your iPad to the
Keynote app on your MacBook Pro. You can also copy something on one device and paste it on the other.

Share a keyboard. When the pointer is in a document or anywhere that you can enter text and the insertion
point is blinking, begin typing.

Learn more. See Use your iPad as a second display for your Mac and Use a keyboard and mouse or trackpad
across devices with Universal Control on Mac.

Apps

Work with apps on your MacBook Pro
Your MacBook Pro comes with a wide range of apps already installed, so you can stay connected with friends
and family, be productive and creative, enjoy hours of entertainment, surf the web, and much more.

Note: Some macOS apps are not available in every region or language.

help:anchor='mchlf3c6f7ae'%20bookID='com.apple.machelp'
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View apps. To quickly see all the apps on your Mac, click   in the Dock.

Tip: Every app that comes with your Mac includes built-in help. To learn how to use an app, go to the app
you want to use, then choose Help > [App] Help in the menu bar. See Use the Mac User Guide.

Open an app. You can have multiple apps open at the same time on your Mac, and leave them open. This is
especially useful for apps you return to frequently, such as Safari or Mail. To open an app, do one of the
following:

Use the Dock: Click the app icon in the Dock. If an app isn’t in the Dock, click  in the Dock, then
click the app. For more information on the Dock, like how to add frequently used apps, see The Dock
on your Mac.

Use the Finder: Click  in the Dock, click Applications in the sidebar of the Finder window, then
double-click the app you want to open.

Tip: To quickly open an app, use Spotlight search. Press Command-Space bar, type the app’s name in the
search field, then press Return. See Search with Spotlight.
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Close an app. Closing an app closes the window, but the app remains open even if there are no active
windows (a small dot below the app’s icon in the Dock indicates that the app is open). To close an app, click

 in the top-left corner of the app’s window.

Quit an app. If you use an app only occasionally, you may want to quit the app when you’re done using it,
especially if the app uses significant energy. To quit an app, choose [App Name] > Quit [App Name] in the
menu bar. For example, choose Preview > Quit Preview.

Note: If an app doesn’t quit as expected or it’s unresponsive, you can force quit the app, though you may lose

unsaved changes. To force quit an app, press Command + Option + Esc or choose Apple menu  > Force
Quit. Select the app in the dialog that appears, then click Force Quit.

Stay connected with FaceTime, Mail, and Messages
Your MacBook Pro offers built-in apps that empower you to stay connected with friends and family, near and
far. Click the link in the table to learn more about FaceTime, Mail, and Messages.



FaceTime

Make and receive video and audio
calls in the FaceTime app on your
Mac.

Get started with FaceTime

Mail

Send and receive email
messages and manage your
mail accounts.

Get started with Mail

Messages

Send and receive iMessages and
SMS/MMS messages with the Messages
app on Mac.

Get started with Messages

FaceTime

With FaceTime, you can make video and audio calls to family and friends, and connect with up to 32 people
in a Group FaceTime call. Not available to talk? Send a message or set a reminder to call back, right in the
app.

Sign in to FaceTime. Before you can make and receive video and audio calls, you need to sign in to
FaceTime. Enter your Apple Account email or phone number and your password in the FaceTime window,
then click Sign In. Don’t remember if you have an Apple Account? If you have an iPhone, go to Settings,
then tap your name. The email you used for your Apple Account appears under your name at the top.

Siri: Say something like: “Make a FaceTime call to Sharon.”

Make a FaceTime call. Use the built-in 12MP Center Stage Camera on your Mac to make FaceTime video



calls. Click New FaceTime, enter a name, phone number, or email address for the person you want to call,

then click . If it’s not convenient to make a video call, you can make an audio-only call: click , then
choose FaceTime Audio.

Tip: Add up to 32 people to a group call. To make a unique link to share with a group, click Create Link at
the top-left corner in the FaceTime window. Copy the link to your clipboard or share directly with friends in
Messages or Mail, or add the link to a Calendar event to schedule a call for later. You can now use a link to
join FaceTime calls on non-Apple devices.

Accept or decline calls. When you receive a FaceTime call, click Accept to join with video. To answer with

audio only, click  next to Accept, then choose Answer as Audio. If you can’t take a call, click Decline—

or click  next to Decline to send a message or get a reminder to call back later.

Choose your background. With macOS Sequoia or later, you can choose a virtual background to express

yourself or just hide the laundry behind you. To change your background, go to the FaceTime app, click 
in the menu bar, then select Background. Click the Background to choose one of the beautiful built-in
backgrounds, or customize your background further by uploading one of your own or choosing from Photos.

Learn more. See the FaceTime User Guide.

Mail

Read, write, and send emails from all your accounts—iCloud, Gmail, Exchange, Yahoo, Outlook, and more
—all in one place.

help:openbook='com.apple.FaceTime.help'


Set up your email accounts. Tired of signing in to multiple websites to check your email accounts? Set up
Mail with all your accounts so you can see all your emails in one place. Choose Mail > Add Account.

Send or schedule an email. To start a new email, click  in the Mail toolbar. Type the recipient’s email

address, enter a subject, and type your message in the space below. When finished with your draft, click 

to send it or  to schedule a time.

Send photos or other files. You can include photos, documents, and more when you write email messages.

To add files, click , locate your file, then select it. To add photos, click  and select the photos you’d
like to send.

Siri: Say something like: “Email Laura about the trip.”



Find emails fast. You can quickly find emails by searching using your own words. In Mail, click  in the
top-right corner and type a word like “photo.” Mail shows emails where the word appears, and a menu allows
you to refine your search by categories like sender or subject.

Tip: Stay organized by setting up custom rules to filter emails—for example, you can block email from a
specific sender by moving their emails directly to the Trash. To add a rule, click Mail > Settings > Rules, then
click Add Rule.

Learn more. See the Mail User Guide.

Messages

Stay connected by sending and receiving messages and media right from your Mac. Search makes it easy to
find messages in a snap, and you can pin your favorite conversations to the top so it’s quick to get in touch
with the people you chat with the most.

help:openbook='com.apple.Mail.help'


Message anyone, on any device. When you sign in to your Apple Account, you can use iMessage to
exchange unlimited messages with anyone with an Apple device. If you have an iPhone, you can also relay

SMS/MMS messages from your iPhone to your Mac. Click  to start a conversation. 

See the Apple Support article What is the difference between iMessage and SMS/MMS? for more
information about different types of messages.

Siri: Say something like: “Message Mom that I’ll be late.”

Add photos, stickers, and more. In a conversation, click , then choose Photos, Stickers, #images, or
Message Effects to add fun media and effects to add to your message. Or easily share files, photos, and
videos by dragging them into Messages.

Tip: With macOS Sequoia, you can now schedule a message to send at a specified time. Click , choose
Send Later, then choose a date and time to send your message.

Find the right message. Find the message you’re looking for quickly by typing a person’s name or keywords
into the search field. Combine search filters to further narrow your search. Your results are organized by
category, such as conversations, messages, and photos.

https://support.apple.com/104972


Keep favorite conversations at the top. Pin your favorite conversations to the top of the messages list by
dragging them to the top. New messages, Tapbacks, and typing indicators appear above a pinned
conversation. When there are unread messages in a group conversation, the most recent participants appear
around the pinned conversation.

Learn more. See the Messages User Guide.

Be productive with Calendar, Notes, Reminders, and Shortcuts
Your MacBook Pro offers built-in apps that empower you to work more efficiently, get organized, and
manage your day with ease. Click the link in the table to learn how to harness the productivity power of
Calendar, Notes, Reminders, and Shortcuts.

Calendar Notes
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Keep track of your schedule by adding
multiple calendars and managing them all in
one place.

Get started with Calendar

Notes is your go-to place for notes of all kinds anytime,
anywhere. Include checklists, audio recordings, images, and
more.

Get started with Notes

Reminders

Create, share, and organize your to-do lists
with the Reminders app on your Mac.

Get started with Reminders

Shortcuts

Create custom automations in your favorite apps to help you
accomplish everyday tasks using Siri or with a click.

Get started with Shortcuts

Calendar

Add calendars, create events and new reminders, complete your to-dos, and share your calendar to keep
others informed in the Calendar app on Mac.

Add multiple accounts. With Calendar, you can add multiple accounts—iCloud, Google, Microsoft
Exchange, and more—and manage all your events from one place. Open the Calendar app, choose Calendar
> Add Account, then follow the onscreen instructions.

Add calendars. You can create separate calendars to keep track of different schedules. For example, keep all



of your work meetings in one calendar and your children’s school events in another. Choose File > New
Calendar. If you have multiple accounts, choose the account for the new calendar. The new calendar appears
in the sidebar. To change the name or color of the calendar, Control-click it, then choose Get Info.

Tip: You can choose to show all your calendars—or just a few. Click  to see a list of all your calendars
and scheduled reminders, then select or deselect a calendar’s checkbox to show or hide it.

Create events and reminders. To create a new event or reminder, click   or double-click a day and time
in the calendar window, then choose Event or Reminder. You can also include additional information, like
location, a URL, or notes. After creating an event or reminder, you can edit it by double-clicking it.
Reminders created in Calendar also sync back to the Reminders app.

Siri: Say something like: “Set up a meeting with Mark at nine in the morning.”

Share a calendar with others. iCloud makes it easy to share calendars. Control-click a calendar under your
iCloud account in the sidebar, then choose Share Calendar. Enter the email of the person you want to share
with.

Learn more. See the Calendar User Guide.

Notes

With many formatting options to help you stay organized, plus powerful search tools, and collaboration
features, the Notes app is your go-to place to jot down notes of all kinds. You can add checklists, images,
audio recordings, and more; collaborate on notes with others; and even solve expressions by typing an equals

help:openbook='com.apple.iCal.help'


sign.

Create or edit a note. Click  in the Notes toolbar to create a new note. To change an existing note, click
anywhere in the note and begin making changes.

Format and add content to notes. You can add checklists, tables, images, links, audio recordings, and more

to your notes. Click  to format text—for example, add a list, make a collapsible subheading or

heading, or highlight text. Click  to record audio,  to add a photo, or  to add a link to another
app.

Collaborate on a note. You can send an invitation to collaborate on a list in Messages or Mail, or share the

link. Click  in the toolbar, choose Collaborate or Send Copy from the pop-up menu, then select Messages,
Mail, or Copy Link. After you’ve invited others to join, you can track activity and manage collaboration by

clicking .



Solve math problems. Crunch numbers, evaluate expressions, and assign variables—right from Notes. To
define a variable, type a word or a letter, followed by the equal sign and the variable’s value. To use a
variable, the variable has to precede any expression it’s used in. To solve an expression, enter the expression
followed by the equal sign.

Tip: Find the note you want when you need it. Click  in the toolbar to show the search field, type what
you’re looking for, then press Return. You can also search a single note by pressing Command-F, then typing
a word or a phrase. Any matches appear highlighted in your note.

Learn more. See the Notes User Guide.

Reminders

Consolidate your to-do lists in one place in the Reminders app. Add new tasks, track your progress, and share
the load with others. Keep track of your reminders on other Apple devices when you use iCloud.

help:openbook='com.apple.Notes.help'


Create a reminder list. You can create a list for each of your projects to help keep your to-dos organized.
With iCloud reminders, you can also create automatically categorized Grocery Lists or custom Smart Lists
based on rules and filters you identify. To create a list, choose File > New List, then choose from Standard,
Groceries, or Smart List.

Note: Grocery lists are not available in all languages.

Add or edit a reminder. Click the space below the last item on a list or click  in the top right to add a

new reminder. You can add notes, tags, a date, or a location to your reminder by clicking .

Siri: Say something like: “Remind me to stop at the grocery store when I leave here.”

Collaborate on a list. Share the load by sending an invitation to collaborate on a list. Click , then choose
Messages, Mail, or Invite with Link. If you share in Messages, everyone on the thread is automatically added
to the list. After you’ve invited others to join, you can track activity, manage collaboration, and even assign
reminders.

Tip: If you’re the organizer of a Family Sharing group, you can create a Family Grocery List that is
automatically shared with members in your Family Sharing group. See Create a Family Grocery List.

help:anchor='remn175e6897'%20bookID='com.apple.reminders.help'


See what’s coming up. Keep on top of upcoming reminders and make sure you never miss a beat. Scheduled
reminders show up in the Calendar app, and in the Today and Scheduled Smart Lists in Reminders. To add a

date to a reminder, hold the pointer over the reminder, click , choose On a Day, then select the date you
want to be reminded.

Learn more. See the Reminders User Guide.

Shortcuts

Use Shortcuts to do everyday tasks using Siri or with a simple click. You can create custom shortcuts, or
choose from hundreds of built-in actions—for example, get directions to the next event in your calendar, send
an ETA, or play a favorite playlist.

help:openbook='com.apple.reminders.help'


Browse the Gallery to find shortcuts. Starter shortcuts for a range of common tasks are grouped in
collections. The shortcuts you create, and ready-made shortcuts you choose or edit, are shown in All
Shortcuts in the sidebar.

Create a shortcut from the gallery. Choose a shortcut from the Gallery to add it to your shortcuts. For

example, in the Quick Shortcuts collection, click Play Playlist, then click . Choose the playlist you want
that shortcut to play, then click Add Shortcut.

Create a custom shortcut. You can also create your own shortcuts. While viewing All Shortcuts, click 
in the toolbar, then drag actions from the list on the right to the shortcut editor on the left to produce the
results you want. Actions are building blocks of a shortcut, like steps in a task. Shortcuts also provides “next
action” suggestions to help you complete your shortcut. For ideas, see Ideas for custom shortcuts.
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Shortcuts to your shortcuts. Using Siri or a widget to run a shortcut is the quickest way to get something
done. You can also add shortcuts to the Finder and the Services Menu, or pin them in the Shortcuts Menu Bar.

Double-click a shortcut, click , then choose options under Use a Quick Action.

Siri: Say something like: “Text last image.”

Learn more. See the Shortcuts User Guide.

Get creative with Photos, Freeform, and iMovie on Mac
Your MacBook Pro offers built-in apps that empower you to create. Click the link in the table to learn more
about getting started with Freeform, Photos, and iMovie.

Photos Freeform iMovie
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Browse, edit, and share your photos
and videos from all of your devices
with Photos.

Get started with Photos

Freeform provides a flexible canvas for
you to pull all the pieces together—solo
or with others.

Get started with Freeform

Create stunning home-videos
and trailers with easy-to-use
tools in iMovie.

Get started with iMovie

Photos

In the Photos app, you can view, edit, and share your photos and videos from all your devices. Use intelligent,
personalized features that help you find, enjoy, and share your best shots and memories.

All your photos on all your devices. With iCloud Photos, you can browse, search, and share all the photos
and videos from all your devices that are signed in to the same Apple Account. When you use your iPhone to
take a photo, it automatically appears on all of your devices. And if you edit photos, those edits appear on all
of your devices, too.

To get started, see Use iCloud Photos.

Import photos. You can import photos from an iPhone, iPad, camera, or files. With Photos open on your
Mac, connect your device or camera and turn it on. If you’re importing from a camera, set it to download
photos. Choose File > Import, select the device in the sidebar, click the photos you want to import, then click
Import [X] Selected.

Tip: To select multiple photos, Command-click to select some photos in a list or Shift-click to select a range
of photos in a list.

help:anchor='phtf5e48489c'%20bookID='com.apple.Photos.help'


Edit photos like a pro. Create standout photos with powerful but easy-to-use editing tools. Double-click a
photo, then use the buttons in the toolbar to make quick improvements, like rotating or automatically
adjusting the color and contrast. For more powerful editing tools, click Edit in the toolbar, then use Smart
Sliders to get professional results.

Browse collections and enjoy your memories. Collections automatically organize your library by topics like
Days, Trips, People, and Memories. To see a personalized collection of photos and videos featuring a
significant person, place, or event from your Photos library, click Memories in the Photos sidebar. The
collection of photos and videos have been set to music, so you can watch them like a movie. To share with

friends and family, double-click the memory, click , then choose how you want to share.

Learn more. See the Photos User Guide.

Freeform

Use the Freeform app to sketch out a project, create a trip itinerary, build a storyboard, design a mood board,
and more. Whether you’re working solo or collaborating on a shared vision, Freeform provides a flexible
canvas for brainstorming.
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Create a board. Click  in the toolbar to create a new board, then start adding content. You can add

almost anything to a board—for example, click  to add a sticky note,  to add text, or  to add
a photo or link. Keep clicking and adding to build your board. Format and move items around until your
board matches your ideas—the bigger, the better.

Collaborate in Freeform. You can send an invitation to collaborate in Messages or Mail, or copy and share

the link. Click  in the toolbar, choose Collaborate, then select Messages, Mail, or Copy Link. If you share
in Messages, everyone on the thread is invited to the board.

Tell a story with your board. Scenes let you organize and present your board section by section in the order

you choose. Click , click , then click Add Scene.

Start on your Mac, finish on your iPad. Sign in to the same Apple Account on all your Apple devices so

you can access your boards, anywhere, anytime. To use iCloud with Freeform, choose  Apple menu >
System Settings, click [your name] in the sidebar, click iCloud, click Show All, then turn on Freeform.

Learn more. See the Freeform User Guide.

iMovie

iMovie lets you turn your home videos into beautiful movies and Hollywood-style trailers that you can share
with a few quick clicks.
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